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INTRODUCTION

This manual is for use with the 09/05/1996 version of Super-MICAR. Please check the date
on the About Super-MICAR screen by pressing {ALT-F1} from the main screen of Super-
MICAR.

What This Manual Is

This is the Super-MICAR System Manager's Manual. It is meant to be used with Super-
MICAR, an automated cause-of-death data processing system. This book also contains
instructions for Utils-MICAR, a utility software package specifically designed for use with
Super-MICAR. The Super-MICAR System Manager's Manual is intended to be a
reference work.

In the event that the software needs to be ordered, there are questions concerning the
software, or if there are questions about data entry, please contact NCHS at one of the
following numbers:

Software Helpline: 1-800-642-8908

Nosology Helpline: 1-800-235-1830

Super-MICAR is an automated cause-of-death data entry system designed as an
enhancement of PC-MICAR. The new system has been updated and is far more user-
friendly. Very little training is required to use Super-MICAR and the on-screen prompts
allow data to be entered with ease.

Super-MICAR is one part of the National Center for Health Statistic's Mortality Medical
Data System. NCHS began developing the system in 1967 to automate the entry,
classification, and retrieval of cause-of-death information reported on death certificates.
Mortality medical data is processed through four basic programs: Super-MICAR,
MICAR , ACME , and TRANSAX .1 2 3
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 Super-MICAR Automates MICAR data entry and medical cause-of-death data
processing, including reporting procedures, full-screen data entry
and editing, query letter generation, and additional information
processing. Super-MICAR is designed to automatically encode
medical cause-of-death data into numeric entity reference numbers
in accordance with the rules expressed in Part 2g of the Vital
Statistics Instruction Manual (VSIM) series. Super-MICAR output
is used by later programs to classify causes of death to their
International Classification of Death (ICD) codes. Super-MICAR
only runs on personal computers.

 MICAR Automates the multiple cause coding rules (see Parts 2b and 2e of
the VSIM series) and assigns ICD codes to each entity.

 ACME Applies World Health Organization (WHO) rules to the ICD codes
determined by MICAR and selects an underlying cause of death
(see Part 2a and 2c of the VSIM series). ACME is available on both
the mainframe and the personal computer. On the PC, ACME and
TRANSAX are distributed as a single product.

 TRANSAX Facilitates the tabulation and use of multiple cause-of-death data.
Through the application of the ICD linkage and modification rules,
TRANSAX translates the axis of classification from an entity to a
record base. TRANSAX is available on both the mainframe and the
personal computer.

The only other manual specifically associated with this one is the Super-MICAR User’s
Guide. The User’s Guide contains instructions on the daily usage of the Super-MICAR
software.

Who This Manual Is For

This manual is intended for the System Manager. It contains instructions on using those
functions of Super-MICAR necessary to the overall data entry process, as well as
installation and file management information. By necessity, some sections of this manual
will overlap the Super-MICAR User’s Guide. However, the Super-MICAR System
Manager's Manual contains instructions for those Menu Options and Functions not
covered in the Super-MICAR User’s Guide. These additional functions of Super-MICAR
will prove useful in helping the System Manager make data entry and processing run
smoothly.
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Changes in This Manual

The Super-MICAR System Manager’s Manual has been updated to match changes that
have been made in the software. These changes are listed below:

Input Record Format Misprint
The misprint of the Age Unit description in the Super-MICAR Input Record Format
(APPENDIX F) has been corrected. The description column should have read:

0: years < 100
1: years > 100
2: months

Changes in the 1996 Version
Several problems in the initial release of the 1996 version of Super-MICAR have been
fixed, usually through the shipment of an Update Disk. A list of these problems has been
provided in this manual for reference. (See pg. 6).

Installation Instructions
Separate installation instructions have been provided to aid in installing Super-MICAR on
a network (see pg. 16).

Minor Corrections
Various minor corrections have been made to this manual so that it accurately matches
what is in the software. Also, the helpline numbers have been added to the introduction to
aid in customer support.

Retitled User’s Guide
The the Super-MICAR Data Processing Manual has been retitled the Super-MICAR
User’s Guide to standardize all the manuals associated with Super-MICAR, PC-MICAR
100/200, and ACME/TRANSAX.

Screen Captures
Several problems were reported with the screen captures contained in this manual. Most of
these were due to differences in types of printers. The screen captures have been
reformatted so that they should appear clean and straight.
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Changes from the 1994/1995 Version

The 1996 version of Super-MICAR software includes numerous changes from the 1995
and other previous versions. Many of the changes are easily apparent, and others might go
almost unnoticed. This section outlines the differences, so that you can quickly familiarize
yourself with them. 

The File System
In the 1996 system, files are stored in a different database format. The new database files
use a Foxpro-compatible X-base database. Data files from previous versions of
Super-MICAR cannot be used by the new system, but will be converted to the new format
when you first open them with Super-MICAR 1996. 

In addition, the entire MICAR data structure for all PC-based MICAR software
(Super-MICAR, PC-MICAR Data Entry, MICAR 100/200, and PC-ACME/TRANSAX)
has been universalized. The data file that Super-MICAR creates contains provisions for
storing the data from all MICAR programs. Thus, you no longer need to generate a
MICAR-100 input file unless you are uploading to a mainframe for MICAR processing.
The PC versions of MICAR 100 can read the same data file format that Super-MICAR
uses, as can PC-ACME/TRANSAX. For more information on data sharing between the
PC-based MICAR systems, see the section The Unified Database later in this manual.

Moved Menu Items
Several of the Functions in the drop-down menus have been moved around. Table 2 (pg.
26) has a complete listing of all menus and Functions.

Exit to DOS
An Exit to DOS Function has been added under the File menu. This allows the user to
immediately access a DOS subsession and enter DOS commands.

Reporting Area
The Reporting Area field that appeared on the batch information screen has been removed.
This data is no longer collected.

Coder Status
At the request of several states, the values for this  field have been expanded to allow
entry of single-digit numbers 0 through 9. 

Place of Injury
Super-MICAR will now accept full text and generate the Place of Injury code from text
entered by the user.
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Activity Code
A new field  that is required under the Tenth Revision of the ICD, Activity Code, has been
added. This new field collects information about the decedent's activity at the time of
death. A pop-up menu of options is available by entering a question mark in the field. For
a complete list of the activity codes, refer to the 1996 version of the 2g manual.

Backup/Remove Option
This new option backs up the open file to a floppy disk, then, if the backup is successful,
deletes the file from your hard drive.

Changes in the 1996 Version

Below is a list of errors in Super-MICAR that have been fixed. If any of the following
problems are occurring, check the program date in the About Super-MICAR screen
{ALT-F1}. The date should read 09/05/1996 or later. If the date is any earlier, then the
current version of Super-MICAR will need to be installed.

The following problems have been found and corrected:

Age and Age Unit. (3/5/96) An error in the program was causing the Age and Age Unit
fields to be set to 999/UNKNOWN on the last certificate entered or edited before exiting
the data entry screen. This error has been corrected. Also, an error occurred causing the
age for decedents over 100 years of age to be stored incorrectly, with their age being
assumed 100 years less than it actually was reported. There is no easy way to recover
these records.

(9/5/96) A bug that changes the Age and Age Unit to 999 (Unknown) has been fixed. This
occurred only in states that read their Super-MICAR demographic information from an
import file. Certificates affected by this bug may have to have their Age and Age Unit data
re-entered.

Date of Injury. (9/5/96) The date of injury and date of surgery fields are no longer
compared to the theoretical birth date (derived from the Age and Date of Death
information).

Header Information Screen. (3/5/96) The header information screen has been modified
to allow the user to review their entry before accpting it.
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Network Access. (4/22/96) Full network compatibility was implemented in 1996, but
several states reported problems with network access when multiple users were entering
data into the same file. These errors included loss of the first record(s) in the file, frequent
messages about locked records, and complete program locks. Because these problems
affected data entry speed and the quality of the data, the option of multi-user access has
been removed. With the March 22 update, only one user can have a file open at a time.
Attempted access by another user will result in a warning.

Super-MICAR can still be installed on a network, but multiple user access to a data file is
no longer available. A datafile can be accessed only by one user at a time.

Processing Errors. (4/22/96) Two data processing errors were corrected with the March
22 update. One occurred when the term GASTROINTESTINAL was entered as G.I., and
caused the program to accept the term as GANGRENE and INTESTINAL.

The other correction concerns the incorrect placement of terms in certificates containing
the term STATUS POST. Also, changes were made to correct an error in date validation
in the Date of Injury and Date of Surgery fields.

(6/12/96) It was discovered, through working with several states, that there was an error in
the dictionary matching routines that occurred only under specific circumstances and
memory configurations. Most states did not experience any problems, but the error has
been corrected with the June 12 update.

(9/5/96) A processing error on certificates containing the term MULTI-INFARCT
DEMENTIA has been corrected. A second error relating to the term COLLAPSED, when
reported as part of an external cause, has also been corrected.

SUP96SAV.EXE Utility. (4/22/96) This new program was provided with the April 22
update disk. If a database file becomes corrupted beyond the point where the Repair Index
Function from the Super-MICAR File submenu can correct it, SUP96SAV.EXE can
usually remedy the situation. SUP96SAV is a recovery program that re-creates the
database file and its index by reading the file and completely rebuilding it.
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INSTALLING Super-MICAR

The installation disks provided with this shipment of Super-MICAR contain the Super-
MICAR and Utils-MICAR files in a compressed format. The files cannot be simply copied
from the disks to your hard drive. Super-MICAR and Utils-MICAR must be installed on
the computer's hard drive in order to function. They cannot be run from a floppy disk. 

System Requirements

Both Super-MICAR and Utils-MICAR are DOS programs and should only be installed on
a personal computer that meet the following minimum requirements:

IBM PC or PC compatible computer
80386 33 MHz CPU or better
640 Kilobytes RAM (see Memory Requirements below)
Hard Drive with sufficient available free storage space (see Memory
Requirements below)
Monochrome monitor (color recommended)
1 3.5" floppy drive (1.44Mb)
DOS 3.3 or higher (DOS 5.0 or higher recommended)

Memory Requirements

Super-MICAR requires 470 Kilobytes (470K) of available RAM at the time the program
is started. (Utils-MICAR requires 458K to create inquiry databases, so if Super-MICAR is
installed and can run, Utils-MICAR will not run into memory problems.) Video drivers,
network drivers, mainframe access software, and other "terminate and stay resident"
(TSR) programs can take up system RAM so that less than 470K of memory are available
when Super-MICAR is started. On systems with DOS 5.0 or greater, use the MEM
command from the DOS prompt to display the amount of available RAM on the system
where Super-MICAR will be installed. With earlier versions of DOS, use the CHKDSK
command to list available memory.

The Super-MICAR software can be installed as one of two versions: a Data Entry version
or a Processing version. Utils-MICAR also has the option of being installed or not. The
Data Entry version supports only those functions specific to data entry (adding and editing
certificates, spell-checking, backing up files, etc.). The Processing version supports all
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functions of Super-MICAR, particularly certificate processing. The Data Entry version
requires around 3 megabytes of free hard drive space. Because of the tables required for
Super-MICAR processing, the Processing version requires 20 megabytes of free hard disk
space. In addition, Super-MICAR requires hard disk space for the data that is entered. 100
certificates requires approximately 140 kilobytes of hard drive space. The user also has the
option of installing Super-MICAR Utilities. These files take up approximately 2
megabytes of hard drive space in addition to the required space for the Processing version
of Super-MICAR. To use the Super-MICAR Utilities, the full Processing version of
Super-MICAR must also be installed.

Option RAM (est) Disk Space (est)
Super-MICAR (Data Entry version) 470K 3 Meg
Super-MICAR (Processing version) 470K 20 Meg
Utils-MICAR 458K 2 Meg

List of Files on the Installation Disks

Below is a list of the files on the installation disks provided for the System Manager's
convenience.

INSTALL.EXE The installation program.

INSTALL.CFG The installation configuration.

PKUNZIP.EXE A data de-compression program.

DISKx.ZIP The file containing the compressed Super-MICAR files that will be
put into the <SUPMICAR> directory. Each installation disk will
have a DISKx.ZIP file, where 'x' is the number of the installation
disk. (Example: DISK2.ZIP will be on Installation Disk #2.)

List of Super-MICAR Files

Below is a list of the files that will be installed by the Super-MICAR installation program.
By default, Super-MICAR is installed in a directory that is named <SUPMICAR>. This
default can be changed during installation. Two other directories will be created as
subdirectories to the <SUPMICAR> directory: these are <DATA> and <TABLES>. The
<DATA> directory contains all of the data files created by Super-MICAR. The
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<TABLES> directory contains all of the tables that Super-MICAR uses in processing and
spell-checking. 

Please note that there are two sets of files. The first set, the data entry files, will always be
installed. The second set, the processing files, will be installed only if the System Manager
tells the installation program to do so.

Data Entry Files

These files are necessary for data entry.

LEXICON.CFG A spell-checker configuration file for all of the LEXICON.* files.
Contains information on LEXICON.DAT and LEXICON.HSH to
tell Super-MICAR how to use these files.

LEXICON.DAT A spell-checker file containing a list of words for use with Super-
MICAR's spell-checking features.

LEXICON.HSH A spell-checker file containing an index to the words in
LEXICON.DAT.

MICAR.CFG A configuration file for all hash tables (MICAR.HSH,
BBDxx.HSH, EXTERNS.HSH, ERNxx.HSH, SNX.HSH,
SNXINDEX.HSH). Contains information on hash file contents.
Without this file, none of the hash tables will open and operate
correctly. This file is installed in the <TABLES> directory.

MICAR.HSH A hash indexed file containing spellings and definitions for 8000+
medical terms. Used as a spell-checker during data entry and for
word definitions during processing. This file is installed in the
<TABLES> directory.

PKUNZIP.EXE A utility that de-compresses files that were archived using PKZIP.
This is called during database restores. This file is installed in the
<SUPMICAR> directory.

PKZIP.EXE A utility that compresses files into smaller ZIP-formatted files. This
file is installed in the <SUPMICAR> directory. This is called
during database backups.
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RULES.HSH A hashed file containing information about specific rules that
should be applied when specific words or word combinations are
encountered. This file is set by NCHS and should not be modified.

SMEDIT.HLP The HELP file for the certificate editing screen. This file is installed
in the <SUPMICAR> directory.

STATES.TXT A file listing information about the states/province in a country. A
list of US states is provided. Any other English speaking country
can use Super-MICAR and modify the state list using any ASCII
file editor. The format is:

Column Item
1-2 2 character abbreviation
3-4 2 digit numeric code
5-24 20 character state/province name

SUP96CVT.EXE A utility program that converts files created with the October, 1995
version of Super-MICAR 1996 to the format used by this, the
January 1996 version. Database files must be converted using this
utility before they can be used with this version of Super-MICAR.
This file is installed in the <DATA> directory. Instructions for
converting databases are in Appendix G: Converting Database
Files, on page 97.

SUPMICAR.EXE The Super-MICAR executable program. This file is installed in the
<SUPMICAR> directory.

SUPMICAR.HLP The HELP file text. This file is installed in the <SUPMICAR>
directory.

UTLMICAR.HLP The HELP file for the certificate editing screen. This file is installed
in the <SUPMICAR> directory.
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Processing Files

These files are necessary for Super-MICAR to process certificates.

BBDxx.HSH The BBDxx.HSH files contain an entity reference number
dictionary for over 121,000 medical causes of death. These are used
during processing to look up entity reference numbers. The
BBDxx.HSH files look up text to find a matching ERN. This file is
installed in the <TABLES> directory.

ERNxx.HSH An index to the entity reference numbers (ERN) that takes an ERN
and returns the associated cause of death. This file is installed in the
<TABLES> directory.

EXTERN.DAT A textual definition of the External Cause prompts. This file is read
to create the menus and selections taken from the External Cause
prompts. This file is installed in the <TABLES> directory.

Database Files

The following files are Super-MICAR database files. They will be generated by Super-
MICAR. The term "filename" is the name of a database file. Database filenames are
supplied by the user when the file is created using the Creating a New Certificate File
(see the Super-MICAR Data Processing Manual) function. Database file names are
restricted to seven characters in length. (The eighth character is used by Super-MICAR for
identification of specific file types, as explained below.) All of these files will be stored in
the <DATA> directory.

filename.DBF A file containing certificate data.

filenameA.DBF A file containing Additional Information certificate data.

filename.FPT A file containing certificate data that is not often filled in, such as
Part Id or the Injury Description. Using this additional file allows
Super-MICAR to make smaller databases.

filenameA.FPT A file containing Additional Information certificate data that is not
often filled in, such as Part Id or the Injury Description. Using this
additional file allows Super-MICAR to make smaller databases.
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filename.HDR A file containing header information for the database file. This
information is the same for every record in the file.

filename.CDX An index to the database file.

filenameA.CDX An index to the Additional Information database file.

filename.SIN A formatted ASCII file that can be imported into Super-MICAR.

filename.SUP A backup file sent to NCHS. This indicates that when the file is sent
to NCHS via modem, it will be forwarded to the Technical Services
Branch (TSB) and not uploaded to the mainframe.

Report Files

Listed below are Super-MICAR files that contain reports created by Super-MICAR:

filename.SER An error listing generated by the processing of a certificate file (see
PROCESSING A CERTIFICATE FILE in the Super-MICAR
Data Processing Manual).

filename.SEX A file created when certificate data is written to a formatted file
using the Export to ASCII File Function (see Exporting
Certificates to ASCII Files, pg. 30).

filename.SQY A report file containing letters generated by the Generate Query
Letters Function (see QUERY MANUAL LETTERS, pg. 36).

filename.SSQ A report file of missing certificates in the database. Created by the
Sequence Check Function (see Generating a Sequence Check in
the Super-MICAR Data Processing Manual).

filename.1IN A MICAR Input file created by Super-MICAR processing.
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File Naming Conventions

As mentioned above, Super-MICAR certificate database files can be given any name of up
to seven characters. For consistency, however, it is recommended that each state use a file
naming convention that allows the system manager to easily identify each file by its name.
NCHS uses a file name convention in which each file is identified by its state
abbreviation, lot number, data year, and coder status. Thus, each filename would look like
this:

SSYYLLL.xxx, where

SS is the state abbreviation.
YY is the 2-digit data year.
LLL is the lot number.
.xxx is the file extension that identifies each type of file, as indicated above.

Thus, the file for Alabama, lot 412, in year 1993, would have the name AL93412.DBF.
While the states are free to use any file naming convention they desire, the file name
convention described above is used to name the backup file when backing up a batch for
shipment to NCHS. 

Installing on a Computer

These instructions are for installing Super-MICAR on a single computer. Super-MICAR is
very easy to install. Simply follow the directions listed below. NOTE: If Super-MICAR is
being re-installed, the old files will be overwritten.

IMPORTANT: The files on the disk are in a compressed format. Super-MICAR cannot
be run from the installation disks. These files MUST be installed using the INSTALL.EXE
program on Disk #1.

1. Place Installation Disk #1 in a disk drive.

2. Switch to the drive containing Installation Disk #1. This can be done by typing the
letter of the drive with a semicolon, and pressing {ENTER} at the DOS prompt.
(Example: Type A: {ENTER} to switch to the A drive.)

3. Type INSTALL and press {ENTER}.
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Figure 1: The Installation Configuration window with sample entries.

4. The Installation Configuration window will appear (see Figure 1). Make any
changes to the data displayed as necessary. The various fields are explained below.

SOURCE DRIVE The drive containing the Installation Diskette (usually
drive A or drive B).

DESTINATION PATH The hard drive on the PC (usually hard drive C or hard
drive D) and directory that will contain the Super-
MICAR files. WARNING: Do not install the Super-
MICAR tables in the same directory with
MICAR100/200. Some files may be overwritten if this
is done.

Change these values... Pressing the following keys will have the listed effects:

{C} Allows the System Manager to change the SOURCE DRIVE and
DESTINATION PATH.

{B} Begins the installation process. See step 5 below.

{ESC} Ends the installation process and returns to DOS.

5. Once the installation configuration has been completed and Begin has been chosen,
a second window will be displayed (see Figure 2). This is where the System
Manager can choose to install the processing files and/or the Utils-MICAR
software. Use the {TAB} key to highlight the appropriate field. Press {Y} to have
the files installed (either the processing files, or the inquiry utilities, or both). Press
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+))))))))))))))))))))))))))))))))))))))))))))))))))))))))))))))))))))))),
*                Select which packages to install           *
/)))))))))))))))))))))))))))))))))))))))))))))))))))))))))))))))))))))))1
*                                                           *
* PROCESSING VERSION                                     Yes *
*                                                           *
* INQUIRY UTILITIES                                      Yes *
.))  Press Enter to install packages, ESC to cancel install )-

Figure 2: This window allows the installation of the processing files.

{N} to prevent installation of one or both packages. Note that without the
processing files, Super-MICAR cannot use any of its processing Functions.

6. When the installation program has been told to install, or not to install, the
processing files, a window will be displayed showing the files being installed. A
progress bar will also be displayed at the top of the screen showing what
percentage of Super-MICAR has been installed. Whenever a new disk needs to be
put in, an instruction window will appear, telling which disk number needs to be
inserted into the disk drive.

7. After the installation is complete, an "Installation Complete" message window will
be displayed. Press any key to return to DOS. Super-MICAR has now been
installed.

Installing on a LAN

Super-MICAR does not have multi-user access to database files. To make the best use of a
LAN, do the following:

1. Install Super-MICAR on a network drive following the same instructions given in
Installing on a Computer (pg. 14). Remember to enter the network drive and path
in the Destination Path field. Example: M:\SUPMICAR.

2. Create a Super-MICAR subdirectory on the local hard drive of the workstation(s)
that will be using Super-MICAR. Example: CD C:\SUPMICAR.

3. Copy the filename.EXE files to the new Super-MICAR subdirectory on the local
hard drive of the workstation. Example: COPY M:\SUPMICAR\*.EXE
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C:\SUPMICAR.

4. Start Super-MICAR on the workstation and set the data path and table path to the
data, table, and backup file paths on the network (see SET A DATA FILE PATH,
pg. 39; SET TABLE FILE PATH, pg. 41; and SET BACKUP PATH, pg. 45).
For the example, the data path would look like this: M:\SUPMICAR\DATA\. And
the table path would look like this: M:\SUPMICAR\TABLES\.

NOTE: If the data and table paths are not set correctly, error messages will be
displayed when Super-MICAR is first started.
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OVERVIEW

Basic Steps

Below is a general outline of the data entry process for Super-MICAR. These are the same
steps that appear in the Super-MICAR Data Processing Manual. The System Manager can
make alterations to the data entry process as needed. Also note that the relevant sections of
this manual are listed next to each step. The actual data entry process has been summed up
into one step. If more details on the data entry are needed, please refer to the
OVERVIEW section in the Super-MICAR Data Processing Manual. A chart depicting
this overview is provided at the end of this section.

1. Start Super-MICAR (STARTING Super-MICAR).

2. Open a certificate file (Creating a New Certificate File or Opening an Existing
File). This step opens a file so that data can be entered and processed. You can
either open an existing file or create a new file. With very few exceptions, every
function that Super-MICAR can perform requires that a file be opened before the
function can be preformed.

3. Edit the certificate file header information as needed (Creating a New Certificate
File). The header information contains constant data that is the same for every
record in the certificate file, such as the data year and the state code.

4. Add certificates to the database (ENTERING AND SAVING CERTIFICATE
DATA). This is the main data entry process. Data can also be read into Super-
MICAR from properly-formatted files. Information on importing and exporting
data is contained in IMPORTING  AND EXPORTING DATA, pg. 28.

5. Mark misspellings/illegible entries for correction (Marking Misspellings/
Illegibles). This function checks all of the records in the file for words that Super-
MICAR does not recognize and/or for the word ILLEGIBLE. (When a data entry
operator cannot read a word on a death certificate, typing the word ILLEGIBLE
will cause this function to mark the record.) Misspelling and illegibles must be
marked before they can be corrected, and the process of marking and correcting
these words should be done after data entry is complete and before processing the
file.
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6. Correct marked misspellings/illegibles (Correcting Misspellings/Illegibles). This
function allows the user to go directly to those records that were marked as having
misspelled or illegible words and correct them. This function can only be used after
misspellings and illegibles have been marked, and should be used before
processing the file.

7. Process the certificate file (PROCESSING A CERTIFICATE FILE). When a
file is processed, Super-MICAR assigns entity reference numbers (ERNs) to the
medical causes of death that were listed in the certificate file. Two steps are
required to completely process a file:

A. Process the entire file (Processing Records). This process attempts to assign
entity reference numbers (ERNs) to all of the medical causes of death for each
record in the open certificate file. This process is done wholly by Super-
MICAR, requiring no input from the user. (This process can also be performed
as a batch process, without going through the menu system. See the section
BATCH PROCESSING FROM THE COMMAND LINE in the Super-
MICAR System Manager's Manual for more information on batch record
processing.)

B. Process the rejects (Processing Rejects). Reject processing requires a trained
MICAR coder. Under reject processing, Super-MICAR displays any records
that were rejected by the Processing Records function. A trained MICAR coder
can examine the record and make whatever changes are necessary to allow the
record to be coded. In order to preserve the original data, modifications can be
made on the Additional Information Screen (Editing Additional
Information).

C. Process Additional Information (Processing Additional Information).

8. Use the editing functions to edit any certificates that were rejected or had other
problems during processing (EDITING FUNCTIONS). The Edit menu contains
several utilities for use in editing the certificates.

9. Generate MICAR100 file (GENERATING A MICAR100 FILE). This file is
used by other MICAR software to continue the process of encoding cause-of-death
data. If this data is to be processed by the 1996 version of PC-MICAR100/200, this
step does not need to be performed.

10. Create a backup for shipment to NCHS (Creating Backups for NCHS). This
function creates a file that can be shipped to NCHS. The file contains all of the data
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collected by Super-MICAR.

11. Close the certificates file (CLOSING A FILE).

12. If there are other certificate files to process, repeat steps 2 through 7.

13. If there are no more files to process, exit Super-MICAR and return to DOS
(EXITING Super-MICAR).

Super-MICAR UTILITIES

Below are listed additional Functions that Super-MICAR can perform. Most of these
utilities can be used at any time with Super-MICAR. Most will require that a certificate
file be open. See the individual description of each utility for more details.

1. Browse through and edit the certificates in a file (Browsing Through the
Certificates). This function allows the user to edit information in the certificate
database, which may be necessary at any time.

2. Find a specific certificate number/record in a file (Finding a Record). This
function is available only when browsing through the certificates and allows the
user to display a particular record by specifying its certificate number.

5. Delete a certificate while editing (Deleting Certificates While Editing a
Certificate File). This function allows the user to remove a record from the
certificate file.

6. Delete several certificates at once (Deleting Several Certificates at Once). This
function allows the user to remove a block of several records from the certificate
file. Use this option if an error has occurred and several certificates have been
entered into the wrong file.

7. Generate a sequence check (Generating a Sequence Check). This function
generates a report that checks the sequence of the certificate numbers in the file. It
is useful in determining if all of the records that should be in the file have been
entered, if unwanted records have been entered, or if records have been entered
with an incorrect certificate number. This function can be used at any time, but is
most useful between data entry and processing to determine if the file is complete.
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8. Print a list of errors detected during last processing (Printing an Error Listing).
This function prints a report listing all of the certificates that were not completely
processed by Super-MICAR. This report may be useful to the person who will
perform reject coding.

9. Print all or selected certificates for review. See Printing All the Certificates
and/or Printing a Single Certificate.

10. Perform a daily backup. (Backing Up All the Files). This function creates a
backup copy of the open certificate file either on your system's fixed drive or on a
floppy. Backing up data is the only protection available against losing data due to a
failed computer system. It is a good idea to back up the certificate file at the end of
every day.

System Manager Functions

Also note that the Super-MICAR System Manager's Manual has instructions for the
following utilities:

1. Import From ASCII File (Importing from an ASCII File, pg. 28).

2. Export To ASCII File (Exporting Certificates to ASCII Files, pg. 30).

3. Repair File Index (REPAIRING A FILE INDEX, pg. 32).

4. Merge Another File (MERGE ANOTHER FILE, pg. 33).

5. Generate a QC Database (GENERATING A QC DATABASE, pg. 34).

6. Printing rejected certificates (PRINTING THE REJECT ERROR LISTING, pg.
35).

7. Generate and Editing Query Letters (QUERY MANUAL LETTERS, pg. 36).

8. Backup and Remove, Restore from Backup (BACKUPS AND RESTORES, pg.
39, 45).

9. Access the DOS Prompt (GETTING TO A DOS PROMPT, pg. 41).
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10. Running Super-MICAR processing from the DOS prompt (BATCH
PROCESSING FROM THE COMMAND LINE, pg. 42).

11. Set Data File Path (SET DATA FILE PATH, pg.43).

12. Set Table File Path (SET TABLE FILE PATH, pg. 44).

13. Set Backup File Path (SET BACKUP FILE PATH, pg.45).

14. Set MICAR 100 Export Path (SET MICAR 100 EXPORT PATH, pg. 46).

15. The Inquiry Database utilities:

STARTING AN INQUIRY DATABASE, pg. 50
THE ONLINE DICTIONARY, pg. 51
SELECTING PARAMETERS, pg. 53
EDITING PARAMETERS, pg. 62, 63, 64, 65, 66, 68
DELETING PARAMETERS, pg. 63
DELETING AN ENTRY, pg. 64
VIEWING PARAMETERS, pg. 65
SELECTING FILTERS, pg. 66
GENERATING THE DATABASE, pg. 68
DELETING OLD DATABASES, pg. 71

16. Creating a Rejects Database (GENERATING A REJECTS DATABASE, pg.
76).
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Figure 3:  The Edit Menu Option and its Functions.

Using the Super-MICAR Menu System

Super-MICAR Functions are available through a drop-down menu system. The menu
system allows the user to quickly select Functions to perform and to move from task to
task quickly and easily. Unlike the menu lists available through other types of software,
Super-MICAR uses a menu system that allows option to be selected from the menu even
when another function is active. This allows users to select Functions more quickly,
without having to exit their way 'back up the tree' before they can select another function.

There are two ways to access the menu: 

ALT-X: Simultaneously pressing the {ALT} key and the highlighted letter key of a
main menu item will display the drop-down menu for that item. (The Alt
keys for each menu option are listed in Table 1.) Then use the up and down
arrow keys to highlight an item on the menu. Press {ENTER} to select the
option. Use the left and right arrow keys to open submenus for other main
menu options. Pressing {ESC} from a dropped-down menu closes the
menu. Pressing {ESC} from the main menu will exit Super-MICAR.

HotKey: Many of the functions in the menus have an associated hotkey. The hotkey
assignments are shown on the drop-down menus and are listed in Table 2.
Pressing a hotkey will immediately access the associated function. (For
example, pressing {F2} will select the Open Existing File function.)
Hotkeys are the fastest, easiest way to move around Super-MICAR. As
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users become familiar with Super-MICAR, they will find the hotkeys easier
to use. 

To select a Function from a drop-down menu, either use the up and down arrow keys to
highlight an option or press the option's selection letter. The selection letter is displayed in
red (on color monitors) or highlighted (on monochrome monitors). Pressing the selection
letter will move the highlight bar to the selected option. 

Figure 3 gives an example of the Edit Menu Option and its Functions.

Not all Functions are available at all times. In order to prevent users from selecting
Functions that should not be accessed during a particular process, the menu system will
make certain Functions available (active) or unavailable (inactive). On color monitors, the
active options are shown in black while inactive options are shown in gray. On
monochrome monitors, inactive options do not have a highlighted selection letter. When
an option is inactive, it cannot be selected (the highlight bar will skip over that item and
it's hotkey will not function). 

TABLE 1: Super-MICAR Menu Options

Key Combination      Menu Option Accessed   

{ALT-F} File Menu Option

{ALT-E} Edit Menu Option

{ALT-P} Process Menu Option

{ALT-R} Reports Menu Option

{ALT-B} Backup Menu Option

{ALT-H} Help Menu Option
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Table 2: Super-MICAR Function Listing

File
{ALT-F2} Create New File
{F2} Open Existing File
{ALT-F4} Close File
{SHIFT-F7} Export to ASCII File
{SHIFT-F8} Import from ASCII File

Repair File Index
Merge Another File

{ALT-F6} Set Data File Path
{SHIFT-F6} Set Table File Path

Set Backup File Path
Set MICAR 100 Export Path
DOS Subsession

{ALT-X} Exit Super-MICAR

Edit
Edit/Browse Header Info

{F3} Add Certificates
{F4} Edit/Browse Certificates
{F9} Edit Additional Info
{ALT-O} Edit Industry/Occupation
{F8} Delete Records
{F5} Find a Record
{F7} Print a Record
{ALT-U} Undo Changes

Process
Mark Misspellings/Illegibles
Correct Misspellings/Illegibles
Process All Records
Process Rejects
Process Additional Info
Generate MICAR100 File

{F6} Show Processed Output
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Reports
Sequence Check
Generate QC Database
Print Error Listing
Print All Certificates
Generate Query Letters

Backup
{ALT-F7} Backup All Files

Backup for NCHS
{ALT-F8} Restore from Backup

Backup and Remove

Help
{F1} View Help File
{ALT-F1} About Super-MICAR
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IMPORTING AND EXPORTING DATA

Importing from an ASCII File

Super-MICAR has the ability to read certificate data files created by other data entry
packages. This data must be in a format that Super-MICAR can read (a filename.SIN file).
APPENDIX D (pg. 94) gives the required format. Instructions for importing certificate
data from another file are given below.

To import data from an ASCII file, follow these steps:

1. Press {ALT-F} to select the File Menu Option.

2. Use the up and down arrow keys to highlight the Import from ASCII File Function.
Press {ENTER}.

3. If a file is currently open, a window will be displayed asking the user to confirm
that the file should be closed before the import is done. Selecting Yes will close the
open file and continue the import. Selecting No will about the import function.

4. A file selection window (see Figure 4) will be displayed.

5. The following fields will be displayed on the file selection window:

Directory
(Pick List of Files)
(Pick List of Directories)
(Pick List of Drives)
Filter
File
OK
CANCEL
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Figure 4:  A file selection window.

6. To select a new disk drive to import files from, do the following:

A. Use the {TAB} key to put the cursor in the Pick List of Drives.

B. Use the up and down arrow keys to highlight the desired drive.

C. Press {ENTER}. The highlighted drive will be selected. Both the Pick List of
Files and the Pick List of Directories will be updated for the new drive.

7. To select a new directory to import files from, do the following:

A. Use the {TAB} key to put the cursor in the Pick List of Directories.

B. Use the up and down arrow keys to highlight the desired directory. The parent
directory (the directory containing the current directory) is listed as "<..>".

C. Press {ENTER}. The highlighted directory will be selected. The Pick List of
Files will be updated for the new directory.



National Center for Health Statistics Super-MICAR

System Manager's Manual Page 29

8. To select a file from the Pick List of Files for importing, do the following. NOTE:
Only files with a .SIN extension can be chosen!

A. Use the {TAB} key to put the cursor in the Pick List of Files.

B. Use the up and down arrow keys to highlight the desired filename.

C. Press {ENTER}. The highlighted file will be selected. The main menu and
Menu Bar will be re-displayed.

9. Once a valid file has been selected it will be imported into the <SUPMICAR>
directory. A progress bar will be displayed showing what percentage of the file has
been imported. When the import is complete, a message will be displayed. Press
{ENTER}. The file selection window (Figure 4) will be re-displayed.

10. When the formatted file has been read, a message window will be displayed. Press
any key to re-display the main screen. The imported file will be open and ready for
use.

Exporting Certificates to ASCII Files

Before files can be exported, the following steps must have already been performed:

A certificate file must be open and have certificates in it (see Creating a New
Certificate File or Opening an Existing File in the Super-MICAR Data Processing
Manual).

Super-MICAR also includes a utility to export certificate data in the same format that it
was received. This utility will normally be used to export data to another system or to
archive data.

1. Only the file that is currently open can be exported. To open a file, see OPENING
A CERTIFICATE FILE FOR PROCESSING in the Super-MICAR Data
Processing Manual. The formatted file will be written to [filename].SEX, where
[filename] is the name of the currently open file.

2. The file will be written following the format given in APPENDIX D (pg. 94).

3. A progress bar will be displayed showing what percentage of the processing is
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complete.

4. When the new files has been created, a message window will be displayed. Press
{ENTER}. WARNING!!! The Additional Information data from Super-MICAR is
given in the same format described in APPENDIX D (pg. 94). All of the certificate
data will be written out, followed by the AI data. A single line of three asterisks
(***) will separate the certificate data from the AI. For example:

All Certificate Data
***
All Additional Information

5. The main screen will be re-displayed.
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REPAIRING A FILE INDEX

Occasionally, the file index may be damaged and need to be repaired. The Repair File
Index Function rebuilds the file index from the data file.

1. Press {ALT-F} to select the File Menu Option.

2. Use the up and down arrow keys to highlight the Repair File Index Function and
press {ENTER}.

3 A message will be displayed, stating that the index is being repaired.

4. When the file index has been completely rebuilt, the main screen will be re-
displayed.
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MERGE ANOTHER FILE

Super-MICAR's Merge Function allows a second certificate file to be merged into the
currently open file. The second file is left unchanged by this Function.

1. Press {ALT-F} to select the File Menu Option.

2. Use the up and down arrow keys to highlight the Merge Another File Function and
press {ENTER}.

3. A progress bar will be displayed showing what percentage of the second file has
been merged with the currently open file. If duplicate certificate numbers exist in
both files, these certificates will not be merged.

4. When the merge is finished, a window will be displayed showing the number of
certificates that were not merged. Press {ENTER}.

5. The main screen will be re-displayed.
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GENERATING A QC DATABASE

Before a QC database can be created, the following steps must have already been
performed:

A certificate file must be open and have certificates in it (see Creating a New
Certificate File or Opening an Existing File in the Super-MICAR Data Processing
Manual).

The file must have been processed already (see PROCESSING A CERTIFICATE
FILE in the Super-MICAR Data Processing Manual).

The Quality Control Database is used by NCHS to validate the manually coded rejects. To
generate the QC database, a certificate file must be open. Do the following:

1. Press {ALT-R} to select the Report Menu Option.

2. Use the up and down arrow keys to highlight the Generate QC Database Function
and press {ENTER}.

3. A window will be displayed showing various percentages. Use the up and down
arrow keys to choose the percentage of the database file (from .1% to 50%) that
will be pulled as a sample. This percentage determines the number of certificates
that will be copied from the database file (filename.DBF) to the quality control file
(QC.DBF) for manual coding. Press {ENTER}.

4. A progress bar will be displayed while the QC database is being created.

5. When the database has been created, the main screen will be re-displayed.

6. To view the QC database certificates, follow the instructions under Opening an
Existing File in the Super-MICAR Data Entry Manual. Open the file named
QC.DBF. Edit the file normally using the instructions under EDITING
FUNCTIONS in the same manual.
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PRINTING THE REJECT ERROR LISTING

Before a rejected certificates can be printed, the following steps must have already been
performed:

A certificate file must be open and have certificates in it (see Creating a New
Certificate File or Opening an Existing File in the Super-MICAR Data Processing
Manual).

The file must have been processed already (see PROCESSING A CERTIFICATE
FILE in the Super-MICAR Data Processing Manual).

To create hardcopy printouts of the certificates in the rejects listing (in other words,
certificates rejected by MICAR200), do the following. As with other Functions, the
relevant database file must be open.

1. From the main screen, press {ALT-R} to select the Reports Menu Option.

2. Use the up and down arrow keys to highlight the Print Error Listing Function and
press {ENTER}.

3. Super-MICAR will attempt to print out an error listing.

A. If Super-MICAR is unable to find a printer, an error message will be displayed.
Press {ENTER} to re-display the main screen.

B. If the printer is located, Super-MICAR will display a "Printing in progress"
message window while the report is being printed.

4. If the report is successfully printed, Super-MICAR will automatically re-display
the main screen.
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QUERY MANUAL LETTERS

Before query manual letters can be generated, the following steps must have already been
performed:

A certificate file must be open and have certificates in it (see Creating a New
Certificate File or Opening an Existing File in the Super-MICAR Data Processing
Manual).

The file must have been processed already (see PROCESSING A CERTIFICATE
FILE in the Super-MICAR Data Processing Manual).

After processing a certificate file, query letters may need to be generated and sent to
various physicians. Query letters are letters requesting confirmation on certificate data. In
these cases, the additional information will need to be gathered and entered as Additional
Information (using the Editing Additional Information section of the Super-MICAR
Data Processing Manual). A listing of example Query Letters is in APPENDIX B -
QUERY MANUAL LETTER SAMPLES (pg. 88). Super-MICAR can check for three
conditions that need such confirmation:

Rare Causes Rare or unusual causes of death. For example: Bubonic Plague.

Trivial Causes Symptoms that do not usually cause death. For example: Headaches
or fever.

Age/Sex Edits Conflicting age/sex information. For example: A male dying of
breast cancer, or a 52 year old woman dying of sudden infant death
syndrome.

Instructions for generating, printing, and editing query letters are given below.

Generating Query Letters

1. Press {ALT-R} to select the Report Menu Option.

2. Use the up and down arrow keys to highlight the Generate Query Letters Function
and press {ENTER}.

3. A progress bar will be displayed.
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4. During processing, a file containing the query letters will be created. The name of
this file is [filename].SQY, where [filename] is the name of the certificate file
being processed.

5. When all of the query letters have been generated, a print request window will be
displayed.

A. To print the query letters, press {Y}.

B. To abort the printing, press {N}.

6. The main screen will be re-displayed.

Editing Query Letters

The ASCII files containing the query letters can be customized for individual needs. These
files (described below) are in standard DOS ASCII format. They can be altered with any
ASCII editor. WARNING!!! These files MUST be saved in ASCII format or Super-
MICAR will be unable to generate query letters. The files containing the basic query
letters are located in the <SUPMICAR/TABLES> directory:

RARE.LET Contains the basic query letter for rare or unusual causes of death (see
Rare Causes above).

TRIVIAL.LET Contains the basic query letter for trivial conditions resulting in death
(see Trivial Causes above).

EDIT.LET Contains the basic query letter for conflicting age/sex information (see
Age/Sex Edits above).

There are also special codes within each of these basic query letters. The codes will cause
certificate information to be printed where the code appears in the letter. These codes and
their relevant certificate information are:

CODE CERTIFICATE INFORMATION

$CERTIFICATE$ The Cause of Death and Injury information from the certificate.

$CERTNUM$ The certificate number.
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$LOTNUM$ The lot number of the certificate.

$DATE$ The current date.

$DEATH_DATE$ The date of the decedent's death.

$EDIT_CAUSE$ A message indicating a conflicting cause of death and age/sex. For
example: A 27 year old man dies from acute respiratory distress
syndrome. This is a condition that is normally valid only for
decedents less than one year of age.

$CAUSE$ The text description of the condition on the certificate that caused
the letter to be generated.
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BACKUPS AND RESTORES

Taking Backups

Super-MICAR uses PKZIP to compress data put into backup files. There are three types of
backup files used by Super-MICAR. Backup All Files creates a backup of a certificate file
(plus its associated files) and stores it in a file called [filename].SBK. The second type of
backup, Backup for NCHS, does the same thing and creates a backup file called
[filename].SCM. The third type creates a backup (called [filename].SBK) and then gives
the user the option to delete the database file from the hard drive. ALL of these files are
compressed using PKZIP.

Backup All Files and Backup for NCHS are described in the Super-MICAR Data
Processing Manual. The Backup and Remove Function is described below:

Backup and Remove

This Function is used to create a backup of a certificate file on a floppy disk. It also
removes the file(s) from the hard drive.

1. Press {ALT-B} to select the Backup Menu Option.

2. Use the up and down arrow keys to highlight the Backup and Remove Function.
Press {ENTER}.

3 A window will be displayed requesting a drive letter to send the backup to. Press
the letter of the drive ('A' for the A: drive, 'B' for the B: drive, etc).

4. A message window will be displayed while the backup is being made.

5. When the backup is finished, another window will appear.

A. To delete the certificate file and all of its associated files from the hard drive,
press {Y} for YES.

B. To abort deleting the files, press {N} for NO.

6. The main screen will be re-displayed.
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Restoring From a Certificate File Backup

Below are instructions on restoring from a certificate backup made using either Backup
All Files or Backup for NCHS (see CREATING BACKUPS in the Super-MICAR Data
Processing Manual). Note that if there is an open file, it must be closed.

1. Press {ALT-B} to select the Backup Menu Option.

2. Use the up and down arrow keys to highlight the Restore From Backup Function.
Press {ENTER}.

3. A file selection window (see Figure 4) will be displayed. Use the {TAB} key to
move the cursor between fields. Use the up and down arrow keys to select the
directory containing the backup file(s) and to select the specific backup file. Press
{ENTER}.

4. A window will be displayed saying that the restore is in progress.

5. When the restore is finished, the restored file will be open and ready for use.

6. The main screen will be re-displayed.
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GETTING TO A DOS PROMPT

For those situations when the System Manager needs to get to a DOS prompt quickly,
without quitting Super-MICAR, there is a DOS Prompt Function under the File menu
option.

1. Return to the main screen.

2. Press {ALT-F} to access the File menu option.

3. Use the up and down arrow keys to highlight the DOS Prompt Function. Press
{ENTER}.

4. This creates a DOS shell. The System Manager can now enter commands through
DOS. When finished, type 'EXIT' and press {ENTER} to return to Super-MICAR.
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BATCH PROCESSING FROM THE COMMAND LINE

Super-MICAR's record processing can be done from the DOS prompt. Batch Super-
MICAR can process approximately 1500 certificates per hour on an average computer.
The user does not need to do anything while the processing is occurring. Batch Processing
performs the same work as described in Processing Records, then produces the MICAR
100 file as described in GENERATING A MICAR100 FILE, both in the Super-MICAR
Data Processing Manual. After the processing is finished, the user can generate a batch
error listing (see PRINTING A PROCESSING ERROR LISTING) and then perform
any editing needed as described in EDITING A CERTIFICATE FILE. Further
processing for rejects (Processing Rejects) may be needed. The instructions for using
Batch Processing from the command line are:

1. In the Super-MICAR directory at the DOS prompt, type SUPMICAR
[filename.DBF] and press {ENTER}. [Filename] must be a valid name for a
database file that exists in the data directory. Example: SUPMICAR
XX91101.DBF.

2. A progress bar will be displayed on the screen showing what percentage of the data
file has been processed.

3. If the processing needs to be interrupted for any reason, press the {ESC} key. The
processing will end and the DOS prompt will be re-displayed.

4. No other activity is needed during processing. When the processing is complete,
the DOS prompt will be re-displayed.
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Figure 5:  The Set Data Path window.

SET DATA FILE PATH

The data file path tells Super-MICAR where the certificate data files are located on the
hard drive. The data path will need to be changed if the data files are put in a different
directory. This menu option will become available only if Super-MICAR cannot find any
database files.

1. Press {ALT-F} to select the File Menu Option.

2. Use the up and down arrow keys to highlight the Set Data File Path Function and
press {ENTER}.

3. A data file path window (see Figure 5) will be displayed.

4. Type in the data file path in the following format:

[drive]:[directory]\

Example: C:\SUPMICAR\DATA\

5. Press {ENTER}.

A. If an invalid path is given, a message window will be displayed. Re-enter the
path or press the {ESC} key to return to the main screen.

B. If Super-MICAR cannot find the data files on the path, a message window will
be displayed. The data path will be reset to its original setting. The main screen
will be re-displayed.

6. If no errors are encountered, the data path will be changed to the new setting and
the main screen will be re-displayed.
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Figure 6:  The Set Table Path window.

SET TABLE FILE PATH

The table file path tells Super-MICAR where the table files are located on the hard drive.
The table files contain medical entities and entity reference numbers (ERNs) that Super-
MICAR uses during processing. This menu option will become available only if Super-
MICAR cannot find any table files.

1. Press {ALT-F} to select the File Menu Option.

2. Use the up and down arrow keys to highlight the Set Table File Path Function and
press {ENTER}.

3. A table file path window (see Figure 6) will be displayed.

4. Type in the table file path in the following format:

[drive]:[directory]\

Example: C:\SUPMICAR\TABLE\

5. Press {ENTER}.

A. If an invalid path is given, a message window will be displayed. Re-enter the
path or press the {ESC} key to return to the main screen.

B. If Super-MICAR cannot find the table files on the path, a message window will
be displayed. The table path will be reset to its original setting. The main screen
will be re-displayed.

6. If no errors are encountered, the table path will be changed to the new setting and
the main screen will be re-displayed.
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Figure 7:  The Set Backup Path window.

‘SET BACKUP PATH

The backup path tells Super-MICAR where to store backed up data. By default, the
backup files are located in the data direcotry. The backup path will need to be changed if
the backup files are put in a different directory.

1. Press {ALT-F} to select the File Menu Option.

2. Use the up and down arrow keys to highlight the Set Backup Path Function and
press {ENTER}.

3. A backup path window (see Figure 7 ) will be displayed.

4. Type in the backup path in the following format:

[drive]:[directory]\

Example: C:\SUPMICAR\BACKUP\

5. Press {ENTER}. If an invalid path is given, a message window will be displayed.
Re-enter the path or press the {ESC} key to return to the main screen.

6. If no errors are encountered, the backup path will be changed to the new setting
and the main screen will be re-displayed.
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Figure 8:  The Set MICAR 100 Path window.

SET MICAR 100 EXPORT PATH

The MICAR 100 export path tells Super-MICAR where to sotre exported MICAR 100
input files.By default, MICAR 100 export files are stored in the data directory. The
MICAR 100 export path will need to be changed if the files are put in a different directory

1. Press {ALT-F} to select the File Menu Option.

2. Use the up and down arrow keys to highlight the Set MICAR 100 Export Path
Function and press {ENTER}.

3. A MICAR 100 path window (see Figure 8) will be displayed.

4. Type in the data file path in the following format:

[drive]:[directory]\

Example: C:\PCMICAR\MIC100\

5. Press {ENTER}. If an invalid path is given, a message window will be displayed.
Re-enter the path or press the {ESC} key to return to the main screen.

6. If no errors are encountered, the data path will be changed to the new setting and
the main screen will be re-displayed.
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UTILS-MICAR

The second part of this manual gives information on the utility software included with
Super-MICAR. These utilities are contained in a separate program from Super-MICAR,
and must be started from DOS. Several new features are available through Utils-MICAR,
such as:

Inquiry Database A database utility for examining certificate files with
user-defined parameters. For example, the user could
build a database of all certificates where the decedent's
age is 1-20 years, inclusive. See page 50 for more
details.

Browse Utility The browse utility allows the user to browse through a
certificate or database file. It does not allow any of the
certificates to be changed. This is especially useful
when an inquiry database has been created. The Browse
utility is explained in more detail on page 72.

Print Rejects Listing The Print Rejects Listing Function allows the user to
print out a list of the certificates that were rejected
during processing. The certificates are printed on the
local printer and will include all of the rejected
certificates. See page 78.

Generate Rejects Database A utility that allows the creation of a database
containing all of the certificates rejected during
MICAR200 processing. See page 76 for a more
thorough explanation.

Generate AI Subset This feature allows the user to generate a database
containing all records with AI (Additional Information).
See page 80.
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Utils-MICAR 1995: TEST1.DBF        - Dictionary Off
 File     Browse    Inquiry   Rejects                       Help

                       F1-Help                            10 04am

Figure 9:  The Utils-MICAR Main Screen.

Starting Utils-MICAR

Starting Utils-MICAR is very similar to starting Super-MICAR:

1. Exit Super-MICAR (if it is currently running).

2. From the DOS prompt in the <SUPMICAR> directory, type 'UTLMICAR' and
press {ENTER}.

3. A startup screen very similar to the Super-MICAR main screen (see Figure 9) will
be displayed.

4. Below is a brief description of the screen. It is very similar to the Super-MICAR
main screen.

File All of the Functions under this Menu Option are the
same as described in the Super-MICAR Data Processing
Manual.

Browse This Menu Option duplicates the Browse Function in
the Super-MICAR Data Processing Manual. No data
may be changed using this Menu Option. It can be used
to examine the currently open file (the Browse Current
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Database Function, pg. 72), or to select any of the
generated inquiry databases (Browse Inquiry Database
Function, pg. 73). Note that this second Function will
cause a file selection window to be displayed containing
a list of already generated inquiry databases for the user
to choose from.

Inquiry The Inquiry Menu Option will probably receive the
most use. This Menu Option lists all of the Functions
associated with manipulating and creating an Inquiry
database. The Functions are described in more detail in
the following sections.

Subsets This Menu Option allows the user to generate a rejects
database, print rejects listing, generate a rejects
database, and generate a subset containing only
certificates with AI. This allows certificates rejected
from MICAR200 processing to be edited in Super-
MICAR, or to have any of the Inquiry Database
Functions performed on them.

Help The Help Menu Option performs the same as described
in the Super-MICAR Data Processing Manual.

Dictionary Off/Online This message at the top of the main screen tells whether
the Online Dictionary is turned off or on. See THE
ONLINE DICTIONARY (pg. 51) for more details
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NOTE: It is faster to use the hot keys listed for Functions under the Inquiry
Menu Option (listed below).

Select Parameters {ALT-C}
Edit Parameters {ALT-E}
Delete Parameters {ALT-P}
Delete Entry {ALT-N}
Select Filters {ALT-L}
Generate Database {ALT-G}
Online Dictionary {ALT-D}
Delete Database {F3}
View Parameters {ALT-V}
Show Info File {ALT-O}

STARTING THE INQUIRY DATABASE

The Inquiry database manager is a separate utility packaged with Super-MICAR on the
Installation Disks. It allows the user to create specialized certificate files, called Inquiry
Database files. These files will contain only those certificates which match certain criteria
set by the user. For example, the user could create a file containing only those certificates
with "CANCER", "MYOCARDIAL INFARCTION", or "GUNSHOT WOUND" as a
cause of death; a file with certificates containing decedents between the ages of 30 and 40
years at the time of death, decedents whose cause of death is listed as a "HOMICIDE", or
any combination of these.

These Inquiry Database files all have filenames in the following format: INQxxxx.DBF.
"xxxx" can be any four characters assigned by the user. The "INQ" at the beginning of the
filename indicates that the database file was generated using the Inquiry Database
functions. This will help prevent accidental deletion of the original certificate file. Inquiry
Database files are intended to be temporary files that will be deleted when they are no
longer needed.

To start the Inquiry database, the DOS prompt must be displayed and the user must be in
the <SUPMICAR> directory. This may means that the user will have to exit Super-
MICAR (by pressing ALT-X). When the DOS prompt is displayed, do the following:

1. Type in the following and press {ENTER}: INQ.EXE
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NOTE: While the Online Dictionary is activated, only terms that appear in the
dictionary can be entered into the Cause of Death and Injury Description
filters. To enter user-defined terms, the Online Dictionary must be
turned off.

THE ONLINE DICTIONARY

The Inquiry Database is very syntax specific. This means that for the Cause of Death and
Injury Description parameters, the Inquiry Database will search only for EXACT
MATCHES. For example, if "ABSCESS" (a misspelling of "ABCESS") is entered as a
Cause of Death filter, only those certificates with the exact spelling of the filter will be
selected for the database. The certificates with the correct spelling, "ABCESS", will not be
selected in this case.

The Online Dictionary provides an automated listing of medical terms that can be included
in the Cause of Death and Injury Description filters. The dictionary has abbreviations,
shorthand formats, as well as the full terms.

Activating the Online Dictionary

Use the instructions below if the Online Dictionary is turned off.

1. Press {ALT-I} to access the Inquiry Menu Option.

2. Use the up and down arrows to highlight the Online Dictionary. Press {ENTER}.

3. IMPORTANT: To indicate that the Online Dictionary is active, "Dictionary
Online" will be displayed on the title bar of the main screen. If the dictionary is
turned off, "Dictionary Off" will be displayed in the title bar of the main screen.
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NOTE: The Online Dictionary can also be activated/deactivated by pressing its
hot keys: {ALT-D}.

Deactivating the Online Dictionary

Use the instructions below if the Online Dictionary is turned on ("Dictionary Online" is
displayed in the title bar of the main screen) and needs to be turned off.

1. Press {ALT-I} to access the Inquiry Menu Option.

2. Use the up and down arrows to highlight the Online Dictionary. Press {ENTER}.

3. The Online Dictionary is now turned off. "Dictionary Off" will be displayed in the
title bar of the main screen.

Using the Online Dictionary

The Online Dictionary will change the way entries are made in the Cause of Death and
Injury Description parameters. Instructions for the using the Online Dictionary with the
Cause of Death and Injury Description parameters are given under the relevant sections
below (Cause of Death, pg. 56; Injury Description, pg. 59)
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+)))))))))))))))))))))))))))))))))))))),
*        Select Parameters       *
/))))))))))))))))))))))))))))))))))))))1
*Age and Age Unit      [  -  ]   *
*Date of Death         [  -  ]   *
*Sex                   [ ]       *
*Cause of Death        [ ]       *
*Manner of Death       [ ]       *
*Date of Injury        [  -  ]   *
*Injury at Work        [ ]       *
*Injury Description    [ ]       *
*Place of Injury       [ ]       *
*Date of Surgery       [  -  ]   *
.))))))))))))))))))))))))))))))))))))))-

Figure 10:  A list of parameters to select from.

NOTE: The Select Parameters option can also be accessed by pressing its hot
keys: {ALT-S}.

SELECTING PARAMETERS

Parameters are basic categories of filters (or selection criteria) used to build the Inquiry
Database. A parameter, for example, can be the Date of Death entry on the certificate. The
filter would then be a specific date of death, such as 12/12 (for December 12). To select
the parameters and create the filters, do the following:

1. Press {ALT-I} to access the Inquiry Menu Option.

2. Use the up and down arrow keys to highlight the Select Parameters Function. Press
{ENTER}.

3. A parameter selection window will be displayed (see Figure 10). Use the up and
down arrow keys to highlight the desired parameter. Press {ENTER}. Instructions
for the specific parameters are given under their individual subsections below.
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Age and Age Unit

The Age and Age Unit allows the user to enter filters based on the age of the decedent.
The user can select an Age Unit (months, days, years, minutes, etc) and then a numeric
range of ages. Example: If MINUTES is chosen as the Age Unit, 1-100 can be entered for
the age for a net result of selecting any decedent between the ages of 1 and 100 minutes. A
maximum of 10 Age and Age Unit parameters may be entered.

1. Select the Age and Age Unit parameter as described under SELECTING
PARAMETERS (pg. 53).

2. A window will be displayed showing a list of units of time. Use the up and down
arrow keys to highlight the desired unit of time and press {ENTER}.

3. Two windows will be displayed. The window in the upper left corner will show all
of the filters for the Age and Age Unit parameter that the user has already entered.
The second window, titled "Enter Age" is described below:

A. To enter the beginning number of the desired age range, position the cursor in
the Beginning Age field and type in any number between 1 and 999. Press
{ENTER}.

B. To enter the ending number of the desired age range, position the cursor in the
Ending Age field and type in any number between 1 and 999. The ending
number MUST be equal to or greater than the beginning number. Press
{ENTER}.

4. The parameter selection window will be redisplayed with the new filter listed.

Date of Death

Like the other parameters in the Inquiry Database, the Date of Death can also be used as a
filter to create a database file of specific certificates. The Date of Death parameter allows
the user to select all certificates whose date of death (month and day) fall within the user-
entered range. A maximum of 10 Date of Death parameters may be entered.

1. Select the Date of Death parameter as described under SELECTING
PARAMETERS (pg. 53).
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NOTE: If '99' is entered as the month, only those certificates with an unknown
month (i.e. '99' for the month) will be included in the database. If '99' is entered for
the day, only those certificates with an unknown day (i.e. '99' for the day) will be
included. If both the month and day of death are '99', then only certificates exactly
matching this entry (certificates with both the month and day entered as '99') will
be in the database.

If '99' is used in the Beginning date, it must also be used in the Ending date.
For example, if the Beginning date is 99/01, the Ending date must have '99' in the
month also. On the other hand, if the Beginning date is 01/99, the Ending date must
also have '99' as the day number.

The user may also make entries such as 99/05 as the Beginning date and 99/10 as
the Ending date. This will generate a database containing certificates with an
unknown month (NCHS code '99' for the month) and with a day from 05-10,
inclusive.

2. Two windows will be displayed. The window in the upper left corner will show all
of the filters for the Date of Death parameter that the user has already entered. The
second window, titled "Enter Date of Death" is described below:

A. To enter the beginning number of the desired date range, position the cursor in
the Beginning Date field and type in the two digit number for the month (01-
12) before the slash, and the two digit day of the month (01-31) after the slash.

B. To enter the ending number of the desired date range, position the cursor in the
Ending Date field and type in the two digit number for the month (01-12)
before the slash, and the two digit day of the month (01-31) after the slash.

C. If the day of death is unknown or invalid (NCHS code 99), enter only the
month and press {ENTER}. '99' will be entered as the day. This will generate a
database of certificates having invalid days between the chosen months. For
example, to generate a list of certificates with unknown days of death from
January to November, enter 01/99 as the Beginning date and 11/99 as the
Ending date.

4. The parameter selection window will be redisplayed with the new filter listed.
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Sex

A maximum of three filters may be entered under the Sex parameter. These three are: M
(for Male), F (for Female), and U (for Unknown).

1. Select the Sex parameter as described under SELECTING PARAMETERS (pg.
53).

2. Two windows will be displayed. The window in the upper left corner will show all
of the filters for the Sex parameter that the user has already entered. For the second
window, titled "Enter Sex (M, F, or U)", press {M} for Male, {F} for Female, or
{U} for Unknown.

3. The parameter selection window will be redisplayed with the new filter listed.

Cause of Death

This parameter allows the user to select certificates with specific cause(s) of death to be
included in the database. A maximum of 10 Cause of Death parameters may be entered.

1. Select the Cause of Death parameter as described under SELECTING
PARAMETERS (pg. 53).

2. Two windows will be displayed. The window in the upper left corner will show all
of the filters for the Cause of Death parameter that the user has already entered.
Depending on whether the Online Dictionary is active, one of two windows will be
displayed:

A. If the dictionary is ON ("Online" appears), a second window will appear
containing a very long list of words. Type in the desired word and the closest
match in the dictionary will be highlighted. Alternatively, the user can use the
page up, page down, up arrow, and down arrow keys to manually highlight the
desired word. Press {ENTER}.

Other keys and key combinations that the user may find helpful are:
{END} Bottom of screen
{END}{END} End of Dictionary.
{HOME} Top of screen
{HOME}{HOME} Beginning of Dictionary
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B. If the dictionary is off, the second window will allow the user to type in the
word(s) that the Inquiry Database will search for. Up to 32 characters may be
typed in. Press {ENTER}.

3. The parameter selection window will be redisplayed with the new filter listed.

Manner of Death

A maximum of 7 Manner of Death parameters may be entered.

1. Select the Manner of Death parameter as described under SELECTING
PARAMETERS (pg. 53).

2. Two windows will be displayed. The window in the upper left corner will show all
of the filters for the Manner of Death parameter that the user has already entered.
The second window will contain a list of manners of death for the user to choose
from. To select a manner of death, do one of the following:

A. Use the up and down arrow keys to highlight the desired entry and press
{ENTER}.

B. Press the first letter of the desired manner of death to highlight the entry. It may
be necessary to press the first letter twice as some entries begin with the same
letter (example: Unclassified and Undetermined). When the desired entry is
highlighted, press {ENTER}. 

3. The parameter selection window will be redisplayed with the new filter listed.

Date of Injury

The Date of Injury parameter allows the user to enter a range of dates that an injury
occurred on. For example, the database file will contain certificates for injuries
occurring between 01/02 (January 2nd) and 10/12 (October 12th). To select certificates
with an unknown or invalid day of injury, enter '99' as the day. A maximum of 10 Date
of Injury parameters may be entered.

1. Select the Date of Injury parameter as described under SELECTING
PARAMETERS (pg. 53).
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NOTE: If '99' is entered as the month, only those certificates with an unknown
month (i.e. '99' for the month) will be included in the database. If '99' is entered for
the day, only those certificates with an unknown day (i.e. '99' for the day) will be
included. If both the month and day of injury are '99', then only certificates exactly
matching this entry (certificates with both the month and day entered as '99') will
be in the database.

If '99' is used in the Beginning date, it must also be used in the Ending date.
For example, if the Beginning date is 99/01, the Ending date must have '99' in the
month also. On the other hand, if the Beginning date is 01/99, the Ending date must
also have '99' as the day number.

The user may also make entries such as 99/05 as the Beginning date and 99/10 as
the Ending date. This will generate a database containing certificates with an
unknown month (NCHS code '99' for the month) and with a day from 05-10,
inclusive.

2. Two windows will be displayed. The window in the upper left corner will show all
of the filters for the Date of Injury parameter that the user has already entered. The
second window, titled "Enter Date of Injury" is described below:

A. To enter the beginning number of the desired date range, position the cursor in
the Beginning Date field and type in the two digit number for the month (01-
12) before the slash, and the two digit day of the month (01-31) after the slash.

B. To enter the ending number of the desired date range, position the cursor in the
Ending Date field and type in the two digit number for the month (01-12)
before the slash, and the two digit day of the month (01-31) after the slash.

3. The parameter selection window will be redisplayed with the new filter listed.
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Injury at Work

A maximum of 2 Injury at Work parameters (one 'Y' and one 'N') may be entered.

1. Select the Injury at Work parameter as described under SELECTING
PARAMETERS (pg. 53).

2. Two windows will be displayed. The window in the upper left corner will show all
of the filters for the Injury at Work parameter that the user has already entered. The
second window, titled "Injury at Work", will have a blank for the user to enter a 'Y'
for yes, or an 'N' for no. Press {Y} for YES, or {N} for NO.

3. The parameter selection window will be redisplayed with the new filter listed.

Injury Description

A maximum of 10 Injury Description parameters may be entered.

1. Select the Injury Description parameter as described under SELECTING
PARAMETERS (pg. 53).

2. Two windows will be displayed. The window in the upper left corner will show all
of the filters for the Injury Description parameter that the user has already entered.
Depending on whether the Online Dictionary is active, one of two windows will be
displayed:

A. If the dictionary is ON ("Online" appears), a second window will appear
containing a very long list of words. Type in the desired word and the closest
match in the dictionary will be highlighted. Alternatively, the user can use the
page up, page down, up arrow, and down arrow keys to manually highlight the
desired word. Press {ENTER}.

Other keys and key combinations that the user may find helpful are:
{END} Bottom of screen
{END}{END} End of Dictionary.
{HOME} Top of screen
{HOME}{HOME} Beginning of Dictionary
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B. If the dictionary is off, the second window will allow the user to type in the
word(s) that the Inquiry Database will search for. Up to 32 characters may be
typed in. Press {ENTER}.

3. The parameter selection window will be redisplayed with the new filter listed.

Place of Injury

A maximum of 7 Place of Injury parameters may be entered.

1. Select the Place of Injury parameter as described under SELECTING
PARAMETERS (pg. 53).

2. Two windows will be displayed. The window in the upper left corner will show all
of the filters for the Place of Injury parameter that the user has already entered. The
second window will display a pick list of places of injury. Use the up and down
arrow keys (or press the first letter of the desired entry) to highlight the desired
entry. Press {ENTER}.

3. The parameter selection window will be redisplayed with the new filter listed.

Date of Surgery

A maximum of 10 Date of Surgery parameters may be entered.

1. Select the Date of Surgery parameter as described under SELECTING
PARAMETERS (pg. 53).

2. Two windows will be displayed. The window in the upper left corner will show all
of the filters for the Date of Injury parameter that the user has already entered. The
second window, titled "Enter Date of Surgery" is described below:

A. To enter the beginning number of the desired date range, position the cursor in
the Beginning Date field and type in the two digit number for the month (01-
12) before the slash, the two digit day of the month (01-31) after the first slash,
and the two or four digit year after the second slash. For example, 01/01/88 for
January 1st, 1988; or 01/01/1988 for the same date.
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B. To enter the ending number of the desired date range, position the cursor in the
Ending Date field and type in the two digit number for the month (01-12)
before the slash, the two digit day of the month (01-31) after the first slash, and
the two or four digit year after the second slash. For example, 12/21/91 for
December 21st, 1991; or 12/21/1991 for the same date.

3. The parameter selection window will be redisplayed with the new filter listed.
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EDITING PARAMETERS

Before parameters can be edited, the following steps must have already been performed:

One or more parameters must already have been entered (see SELECTING
PARAMETERS, pg. 53).

The process for editing a parameter the user has already created is very similar to the
creation of a parameter itself. The Edit Parameter Function will not be accessible if no
parameters have been created using Select Parameters (see SELECTING
PARAMETERS, pg. 53).

1. From the main screen, access the Inquiry Menu Option by pressing {ALT-I}.

2. Use the up and down arrow keys to highlight the Edit Parameter Function. Press
{ENTER}.

3. A window will be displayed showing a list of all of the parameters the user has
created so far. Use the up and down arrows to highlight the parameter that needs to
be edited. Press {ENTER}.

4. From this point on, editing the parameter is the same as it's initial creation. Refer to
the appropriate section under SELECTING PARAMETERS (pg. 53) for details
on how to re-enter the parameter. A list of the parameters, and the page of this
manual the instructions are in, appears below.

Age and Age Unit pg. 54
Date of Death pg. 54
Sex pg. 56
Cause of Death pg. 56
Manner of Death pg. 57
Date of Injury pg. 57
Injury at Work pg. 59
Injury Description pg. 59
Place of Injury pg. 60
Date of Surgery pg. 60
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DELETING PARAMETERS

Before parameters can be deleted, the following steps must have already been performed:

One or more parameters must already have been entered (see SELECTING
PARAMETERS, pg. 53).

The Delete Parameters Function will delete all of the entries made under a particular
parameter (whereas the Delete Entry Function will delete only a specific entry). For
example, if the user has entered 4 Cause of Death filters, the Delete Parameters Function
will delete all 4 of the filters (Delete Entry will remove only 1 of the 4 entries). Deleting
parameters can only be performed after parameters have first been created (see
SELECTING PARAMETERS, pg. 53). The procedure for doing this is very easy:

1. From the main screen, access the Inquiry Menu Option by pressing {ALT-I}.

2. Use the up and down arrows to highlight the Delete Parameters Function. Press
{ENTER}.

3. A window will be displayed showing a list of parameters that have already been
created. Use the up and down arrow keys to highlight the desired parameter and
press {ENTER}.

4. A second window will be displayed, showing a list of all filters that have been
entered under the selected parameter. A third window, with the message, "Delete
All Inputs (Y/N)?".

A. To delete all of the filters entered under this parameter, press {Y}. That
parameter, and all of the filters entered into it, will be deleted. Return to step 2.
If all of the parameters are deleted, a message window will be displayed. In this
case, press {ENTER} to return to the main screen.

B. To abort the deletion of the parameter, press {N}. Return to step 2.

C. To end the deletion, press {ESC}. The main screen will be re-displayed.
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DELETING AN ENTRY

Before an entry can be deleted, the following steps must have already been performed:

One or more parameters must already have been entered (see SELECTING
PARAMETERS, pg. 53).

The Delete Entry Function differs from the Delete Parameters in that deleting an entry will
delete only 1 filter from a list of filters. In other words, if the user has entered 4 Age of
Death parameters, Delete Entry will delete only 1 of those 4. (The Delete Parameter
Function would delete all 4.) This Function will work only if parameters have already
been entered into the Inquiry Database (see SELECTING PARAMETERS, pg. 53).

1. From the main screen, access the Inquiry Menu Option by pressing {ALT-I}.

2. Use the up and down arrows to highlight the Delete Entry Function. Press
{ENTER}.

3. A window will be displayed showing a list of parameters that have already been
created. Use the up and down arrow keys to highlight the desired parameter and
press {ENTER}.

4. A second window will be displayed showing the entry selected for deletion. A
message will appear asking to confirm the deletion.

A. To delete the selected entry, press {Y}. The entry will be removed from the list.
The user may delete another entry (see step 3 above).

B. To abort the deletion and return to the list of parameters, press {N}. The user
may select another entry for deletion (see step 3 above).

C. To return to the main screen without deleting any entries, press {ESC} until the
main screen is redisplayed.
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NOTE: The View Parameters Function can also be accessed by pressing its hot
keys: {ALT-V}.

VIEWING PARAMETERS

Before parameters can be viewed, the following steps must have already been performed:

One or more parameters must already have been entered (see SELECTING
PARAMETERS, pg. 53).

This Function allows the user to take a look at the parameters and filters that have been
entered. Any filters that have been selected (see SELECTING FILTERS, pg. 66) will
also be marked with a plus sign (+) on either side of the entry.

1. From the main screen, access the Inquiry Menu Option by pressing {ALT-I}.

2. Use the up and down arrows to highlight the View Parameters Function. Press
{ENTER}.

3. A window will be displayed showing a list of all parameters and entries that have
been made so far. Use the {PgUp} and {PgDn} keys, or the arrow keys, to scroll
through long lists.

4. When the user is finished viewing the list, press the {ESC} key. The main screen
will be re-displayed.
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SELECTING FILTERS

Before specific filters can be selected, the following steps must have already been
performed:

At least two parameters must already have been entered (see SELECTING
PARAMETERS, pg. 53).

The Select Filters Function allows the user to select specific filters from a list of filters.
These selected filters will be the only filters used to create the inquiry database. This
function will normally be used when the user has several different inquiry databases to
create. With this Function, a "master list" of filters can be created, then individual filters
can be selected/de-selected for each inquiry database. For example, the user creates a list
of Sex filters (see Sex, pg. 56) - M, F, U. Then the user goes to Select Filters and selects
M in the list of possible Sex filters. The inquiry database generated from these parameters
will contain only sex M certificates. The user can then go back into Select Filters, de-
select M, and select U to generate an inquiry database containing only sex U certificates.

Only those parameters with more than one entry can have a single filter selected from
them. And any parameter with more than one entry can have a filter selected. Thus, the
user can have 4 age entries, 3 sex entries, and 5 cause of death entries, and generate
inquiry databases using just 2 age, 1 sex, and all 5 cause of death filters, or any
combination of these. At least one parameter must have more than 1 entry in order to use
this Function (see SELECTING PARAMETERS, pg. 53). The instructions below are
used for selecting and de-selecting a filter.

NOTE: If the user wishes to use all of the entries under a given parameter (such as all 5
cause of death entries in the example above), none of the filters under that parameter need
to be selected.

1. From the main screen, access the Inquiry Menu Option by pressing {ALT-I}.

2. Use the up and down arrow keys to highlight the Select Filters Function. Press
{ENTER}.

3. A window will appear showing a list of all parameters having two or more entries.
Use the up and down arrow keys to highlight the entry to be used as a filter. Press
{ENTER}.



National Center for Health Statistics Super-MICAR

System Manager's Manual Page 67

4. A second window will appear asking the user to confirm selecting this entry as a
filter.

A. To select the entry as a filter, press {Y}. The entry will then have a plus
sign (+) next to it in the listing. When the inquiry database is generated,
only those entries with a (+) next to them under this parameter will be
used.

B. To de-select the entry as a filter (if it has already been marked as a filter),
press {N}. The plus sign (+) will be removed from the entry in the listing.

C. To abort selection of the entry as a filter, press {N}.

5. The user may select additional entries as filters (see step 3), or press {ESC} to
return to the main screen.
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NOTE: The Generate Database Function can also be accessed by pressing its hot
keys: {ALT-G}.

GENERATING THE DATABASE

Before the inquiry database can be generated, the following steps must have already been
performed:

At least one parameter must already have been entered (see SELECTING
PARAMETERS, pg. 53).

If more than one parameter has been entered, the user can select specific filters from the
list of parameters (see SELECTING FILTERS, pg. 66).

Generating an inquiry database is the easiest part about using Utils-MICAR. You must
have filters selected in order to generate the database (see SELECTING FILTERS, pg.
66).

1. From the main screen, access the Inquiry Menu Option by pressing {ALT-I}.

2. Use the up and down arrow keys to highlight the Generate Database Function.
Press {ENTER}.

3. A window will be displayed requesting a file name. Enter a filename of up to 4
characters. If all four characters are used, the filename will be automatically
entered. Otherwise, the user will have to press {ENTER}.

4. A progress bar will be displayed showing the progress Super-MICAR has made in
creating the inquiry database.

5. When processing is completed, a message window will be displayed.

A. If no certificates were found matching the criteria, a message window will be
displayed. No inquiry database file will be created. Press {ENTER}.

B. If certificates matching the criteria were found, a message window will be
displayed showing how many such certificates are in the inquiry database file.
A new file called INQxxxx.DBF (where xxxx is the user-chosen four letter
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sequence from step 3) will be created. This file is a regular database file and
can have Super-MICAR or Utils-MICAR functions performed on it. Press
{ENTER}.

6. The main screen will be re-displayed.
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VIEWING FILE INFORMATION

Before file information can be viewed, the following steps must have already been
performed:

An inquiry database must have already been created (see GENERATING THE
DATABASE, pg. 68).

The parameters used to create a particular inquiry database file can be viewed using a
special function. This will help the System Manager have better knowledge of what a
particular inquiry database contains.

1. From the main screen, access the Inquiry Menu Option by pressing {ALT-I}.

2. Use the up and down arrow keys to highlight the Show Info File Function. Press
{ENTER}.

3. A file selection window similar to the one in Figure 4 will be displayed. The
window will contain a list of inquiry database files that have been generated in the
Pick List of Files.

4. Use the {TAB}, up, and down arrow keys to highlight the desired file. Press
{ENTER}.

5. A list of the filters used to generate the inquiry database file will be displayed.

6. For very long lists of parameters, the up and down arrow keys as well as the
{PgUp} and {PgDn} keys can be used to scroll through the listing.

7. When the user is finished viewing the parameters, press the {ESC} to return to the
main menu.
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DELETING OLD DATABASES

Before a database can be deleted, the following steps must have already been performed:

An inquiry database must have already been created (see GENERATING THE
DATABASE, pg. 68).

Most databases will be deleted soon after they are created. This utility will delete only
those databases created using Utils-MICAR. Here is how it works:

1. From the main screen, access the Inquiry Menu Option by pressing {ALT-I}.

2. Use the up and down arrow keys to highlight the Generate Database Function.
Press {ENTER}.

3. A file selection window (see Figure 4) will be displayed.

4. Use the tab key to position the cursor in the Pick List of Files. Then use the up and
down arrows to highlight the inquiry database file to be deleted. Press {ENTER}.

5. A window will be displayed asking to confirm the deletion.

A. To delete the file and return to the main screen, press {Y}.

B. To abort the deletion and return to the main screen, press {N}.



Super-MICAR National Center for Health Statistics

Page 72 System Manager's Manual

VIEWING CERTIFICATES WITH BROWSE

Utils-MICAR's Browse functions are very similar to Super-MICAR's Browse function,
save that in Utils-MICAR, data cannot be changed.

Browsing Through a Database File

Before a database file can be viewed, the following steps must have already been
performed:

A database file must be open (see Opening an Existing File in the Super-MICAR Data
Processing Manual).

This Function allows the user to browse through the currently open file and view the
certificates. A certificate file must be open in order to use this Function.

1. From the main screen, press {ALT-B} to select the Browse Menu Option.

2. Use the up and down arrow keys to highlight the Browse Current Database
Function and press {ENTER}.

3. The Certificate Information Screen (see Figure 11) will be displayed. Descriptions
of this screen and its fields can be found in the Adding Certificates section of the
Super-MICAR Data Processing Manual.

4. The {PgUp} and {PgDn} keys will cause the preceding or next certificate to be
displayed.

5. When finished viewing the certificates, press the {ESC} key. The main screen will
be re-displayed.
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Browsing Through an Inquiry Database

Before a database file can be viewed, the following steps must have already been
performed:

An inquiry database file must be open (see Opening an Existing File in the Super-
MICAR Data Processing Manual).
An inquiry database must have already been created (see GENERATING THE
DATABASE, pg. 68).

The Browse Inquiry Database Function performs exactly as the Browse Current Database
Function. The only difference is that Browse Inquiry Database allows only inquiry
databases to be viewed.

1. From the main screen, press {ALT-B} to select the Browse Menu Option.

2. Use the up and down arrow keys to highlight the Browse Inquiry Database
Function and press {ENTER}.

3. A file selection window (see Figure 4) will be displayed containing a list of all the
inquiry databases that have been created thus far. Use the {TAB} and arrow keys
to highlight the desired file in the Pick List of Files and press {ENTER}. The
selected file will be opened for viewing.

4. The Certificate Information Screen (see Figure 11) will be displayed. Descriptions
of this screen and its fields can be found in the Adding Certificates section of the
Super-MICAR Data Processing Manual.

5. The {PgUp} and {PgDn} keys will cause the preceding or next certificate to be
displayed.

6. When finished viewing the certificates, press the {ESC} key. The main screen will
be re-displayed.
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Super-MICAR 1995: TEST1.DBF
File Browse Inquiry Subset Help

Certificate: 000014 Sex: Date of Death:
Age: Unit: State of Death:

Conditions Causing Death Duration
Ia:
Ib:
Ic:
Id:

II:

Manner of Death: Date of Injury: Injury at Work?:

Injury Description:

Place of Injury: Date of Surgery:

Activity Code: State-Specific Data:

F9: Add AI Screen Alt-U: Undo Ctrl-Enter: Save
Alt-O: Occ/Ind Screen Alt-F9:     Save/Exit

Esc:        Exit

Field Description F1-Help Record Count      2 58pm

Figure 11:  The Certificate Information Screen.

Searching for a Specific Record

Before a search can be done, the following steps must have already been performed:

A database file must be open (see Opening an Existing File in the Super-MICAR Data
Processing Manual).

There is a search utility available with both of the Browse Functions described above. This
search utility allows the user to view a specific certificate without having to use {PgUp}
and {PgDn} to go through an entire file. Here are the instructions:

1. While the Certificate Information screen is displayed (by using either of the
Browse Functions), press {F5}.

2. A window (see Figure 12) will be displayed.
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+))))))))))))))))))))))))))))))))))))))))))))))))))),
*          Certificate Number Search         *
/)))))))))))))))))))))))))))))))))))))))))))))))))))1
*                                            *
* Enter the certificate number to edit:      *
*                                            *
.)))))))))))))))))))))))))))))))))))))))))))))))))))-

Figure 12:  Enter the number to find.

3. Type in the certificate number of the desired certificate and press {ENTER}.

A. If the certificate number is in the currently open file, that certificate's data will
be displayed.

B. If the certificate number is not in the currently open file, a message will be
displayed. Press {ENTER}.

4. The Certificate Information Screen will be re-displayed.
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File Browse Inquiry Subsets Help

644444444444444444444444444444444444444444444444444444444447
5          Select death record input file         5
K))))))))))))))))))))))))))))))))))))))))))))))))))))))))))M
5+) Directory )))))))))))))))))))))))))))))))))))),  5
5* C:\SUPMICAR\DATA\                        *      5
5.))))))))))))))))))))))))))))))))))))))))))))))-  5
5  Files          Directories                     5
5  TEST1.2RJ      <..>           +) Filter )))))),   5
5  TEST2.2RJ                     **.2RJ       *   5
5                                .))))))))))))))-  5
5                                                 5
5                                +) File )))))))),   5
5                                *TEST1.2RJ   *   5
5                                .))))))))))))))-  5
5                                                 5
5                                                 5
5                 Drives               OK    (    5
5                 A:              &&&&&&&&&&&&&&   5
5                 B:                 CANCEL  (    5
5                 C:              &&&&&&&&&&&&&&   5
944444444444444444444444444444444444444444444444444444444448

Alt-F-Menu 11:19am

Figure 13:  A file selection window. The files listed are sample files and are not included
with the installation disks.

GENERATING A REJECTS DATABASE

The Inquiry Database has the ability to create a file of certificates rejected from
MICAR200 processing. This requires both the database file containing the full certificate
information (filename.DBF) and a file listing the certificates rejected from MICAR200
processing (filename.2RJ). To create and edit the rejects database requires some work, as
described below. Please note that the relevant .DBF file must be open to use this Function.

1. Press {ALT-R} to select the Subsets Menu Option.

2. Use the up and down arrow keys to highlight the Generate Rejects Database
Function and press {ENTER}.

3. A file selection window (see Figure 13) will be displayed. Select the file
containing the list of certificate numbers rejected from MICAR200 and press
{ENTER}.
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A. If a rejects database already exists for the selected file, a message window will
be displayed asking to confirm overwriting the existing database.

B. To overwrite the existing database, press {Y}.

C. To abort creating a new rejects database, press {N}. The main screen will be
re-displayed.

4. A progress bar will be displayed. To abort the process, press the {ESC} key.

5. The Inquiry Database will create a new database file called filenameR.DBF, where
"filename" is the first six letters of the name of the database file the certificates
were pulled from. (For example: rejects from the database file TESTDAT.DBF will
be put in the file named TESTDAR.DBF. Notice that the 3rd 'T' has been dropped.)

6. When the Inquiry Database is finished creating the new database, the main screen
will be re-displayed.
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Figure 14:  A file selection window containing a list of reject files. These are sample
files only.

PRINTING A REJECTS LISTING

This Function is used to print out copies of the rejects. The currently open file must have
rejects.

1. From the main screen, press {ALT-S} to select the Subsets Menu Option.

2. Use the up and down arrow keys to highlight the Print Rejects Listing Function and
press {ENTER}.

3. A file selection window (see Figure 14) will be displayed containing a list of files
with rejects. Use the up and down arrow keys to highlight the desired file in the
Pick List of Files and press {ENTER}.

4. A window will be displayed as the printer generates the rejects report.
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5. Once the printer is initialized, a second window will be displayed asking the user to
confirm printing the report.

A. To print the report, use the {TAB} key to highlight YES and press {ENTER}.

B. To abort printing the report and return to the main screen, use the {TAB} key
to highlight NO and press {ENTER}.

6. A third window will be displayed while the rejects are being printed.

7. The main screen will be re-displayed once all the rejects are printed.
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GENERATING AN AI SUBSET

This Function will create a database file from the currently open file. This created file will
contain only certificates with Additional Information (AI). The AI database will be placed
in a file named filenameS.DBF, and it can be viewed using the browse database function.

1. From the main screen, press {ALT-S} to select the Subsets Menu Option.

2. Use the up and down arrow keys to highlight the Generate AI Subset Function and
press {ENTER}.

3. A progress bar will be displayed as the database file is searched and the certificates
with AI are copied into a new database file.

4. When the entire file has been searched, a message window will be displayed
showing how many certificates with AI were copied into the new file.

5. Press {ENTER} to return to the main screen.
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APPENDIX A - NCHS STATE CODES

Code State Abbrev. Code State Abbrev.
01 Alabama AL 28 Nebraska NE
02 Alaska AK 29 Nevada NV
03 Arizona AZ 30 New Hampshire NH
04 Arkansas AR 31 New Jersey NJ
05 California CA 32 New Mexico NM
06 Colorado CO 33 New York NY
07 Connecticut CT 34 North Carolina NC
08 Delaware DE 35 North Dakota ND
09 Dist. Columbia DC 36 Ohio OH
10 Florida FL 37 Oklahoma OK
11 Georgia GA 38 Oregon OR
12 Hawaii HI 39 Pennsylvania PA
13 Idaho ID 40 Rhode Island RI
14 Illinois IL 41 South Carolina SC
15 Indiana IN 42 South Dakota SD
16 Iowa IA 43 Tennessee TN
17 Kansas KS 44 Texas TX
18 Kentucky KY 45 Utah UT
19 Louisiana LA 46 Vermont VT
20 Maine ME 47 Virginia VA
21 Maryland MD 48 Washington WA
22 Massachusetts MA 49 West Virginia WV
23 Michigan MI 50 Wisconsin WI
24 Minnesota MN 51 Wyoming WY
25 Mississippi MS 52 Puerto Rico PR
26 Missouri MO 53 Virgin Islands VI
27 Montana MT 54 Guam GU

55 New York City YC*

* Code 55 is used for occurrence data only. When coding residence data on the demographic
file, code 33 (New York State) must be used.
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APPENDIX B - MENU LISTINGS

Super-MICAR Menu Options

Key Combination        Menu Option Accessed   

{ALT-F} File Menu Option

{ALT-E} Edit Menu Option

{ALT-P} Process Menu Option

{ALT-R} Reports Menu Option

{ALT-B} Backup Menu Option

{ALT-H} Help Menu Option
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Super-MICAR Function Listing

File
{ALT-F2} Create New File
{F2} Open Existing File
{ALT-F4} Close File
{SHIFT-F7} Export to ASCII File
{SHIFT-F8} Import from ASCII File

Repair File Index
Merge Another File

{ALT-F6} Set Data File Path
{SHIFT-F6} Set Table File Path

DOS Subsession
{ALT-X} Exit Super-MICAR

Edit
Edit/Browse Header Info

{F3} Add Certificates
{F4} Edit/Browse Certificates
{F9} Edit Additional Info
{ALT-O} Edit Industry/Occupation
{F8} Delete Records
{F5} Find a Record
{F7} Print a Record
{ALT-U} Undo Changes

Process
Mark Misspellings/Illegibles
Correct Misspellings/Illegibles
Process All Records
Process Rejects
Process Additional Info
Generate MICAR100 File

{F6} Show Processed Output
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Reports
Sequence Check
Generate QC Database
Print Error Listing
Print All Certificates
Generate Query Letters

Backup
{ALT-F7} Backup All Files

Backup for NCHS
{ALT-F8} Restore from Backup

Backup and Remove

Help
{F1} View Help File
{ALT-F1} About Super-MICAR



National Center for Health Statistics Super-MICAR

System Manager's Manual Page 85

APPENDIX C - DICTIONARY OF TERMS USED

Since not everyone will be familiar with the terms used in these instructions, here is a brief
glossary of some of the words.

Certificate File - A file containing certificate data. This term is used interchangeably
with Database File.

Data Directory - A subdirectory on the computer where Super-MICAR certificate
files are stored. By default, the data directory is a subdirectory of
the <SUPMICAR> directory called <DATA>. The default value
can be changed through Super-MICAR.

Database file - A file containing certificate data. This term is used interchangeably
with Certificate File.

Directory - A specific grouping of files on a disk. Also referred to as a
subdirectory. The directory that will be used most with Super-
MICAR will be the <SUPMICAR> directory.

DOS - A Disk Operating System. The System Manager will handle most
operations that deal with DOS. The only time the data entry
personnel will use DOS will be in the STARTING Super-MICAR
section of this manual.

Export - To take data from the Super-MICAR certificate database and place
it in a formatted file that is readable by other programs.

Extension - A 3-letter identifier at the end of a filename that identifies what type
of file it is. For example: .EXE is an executable file, .DBF is a
database file, and so forth.

Filename - The name of a file on a disk. Example: SUPMICAR.EXE is made
up of the filename SUPMICAR and extension .EXE.

Hotkey - A key or pair of keys that can be pressed to access a menu function
directly, without going through the menu system. For example,
pressing the F2 key will access the Open a File menu option.

Import - To read data from a formatted file and place it in a Super-MICAR
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certificate database. 

Menu - A list from which to select an action that Super-MICAR can
perform. Super-MICAR has both a main menu and submenus. The
main menu appears as a bar across the top of the screen, just below
the program name. From the main menu, a submenu can be selected
listing actions to be performed. See the section Using the Super-
MICAR Menu System (pg. 24) for more details on how to use the
menu.

Pick List - A list of items that can be selected (picked) by using the up and
down arrow keys to highlight the desired item and then pressing
{ENTER}.

Subdirectory - See Directory above.

Submenu - A group of related actions arranged into a list from which an action
can be selected. Submenus are available through the main menu.
See the section Using the Super-MICAR Menu System (pg. 24)
for more information on the menu system.

Table - A subdirectory on the computer where Super-MICAR processing
Directory files are stored. By default, the table directory is a subdirectory of

the <SUPMICAR> directory called <TABLES>. The default value
can be changed through Super-MICAR.
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APPENDIX D - CONVENTIONS USED IN THIS MANUAL

The conventions used in this manual are the same as for the Super-MICAR Data
Processing Manual. They are repeated here for convenience.

1. All of the actual typing and keys that need to be pressed will be given in all-caps
(Example: type DIR and press {ENTER} to get a list of files in a directory).

2. Any information that the user needs to provide, such as filenames, will be
requested in brackets (Example: type [filename.ext] means that the user needs to
type in the filename and its extension, like so: type WY91001.DBF, without the
brackets.)

3. When the word "press" appears in front of a word in all-caps, the user needs to
press and release a particular key (Example: press {ESC} means press and release
the ESC key). Also, the names of all keys will be given in braces {}.

4. Whenever two keys are named with a hyphen ( - ) connecting them, both keys are
to be pressed at the same time to perform the listed function (Example:
{CTRL-ENTER} = press and hold the {CTRL} and {ENTER} keys at the same
time).

5. At times, references will be made to other Menu Options or Functions of
Super-MICAR. The following standards will be used in these cases:

A. Any selection from the Main Menu (the menu that runs across the top of the
Super-MICAR screen, just below the title) will be called a Menu Option
(Example: the File Menu Option).

B. Any selection from a submenu will be called a menu Function or just Function
(Example: the Browse Certificates Function).

6. All directory names will be marked by greater than and less than symbols
(Example: The directory containing the Super-MICAR programs is the
<SUPMICAR> directory).
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APPENDIX E - QUERY LETTER SAMPLES

Below is a query letter used to request more information on a decedent. The terms
between the dollar signs ($) are positions where Super-MICAR will fill in appropriate data.

                                                Stat S. Tician
                                                State Dept. Vital Statistics
                                                P.O. Box 00000
                                                Capital City, NC  27709

$DATE$

Regarding death certificate:

Lot Number:  $LOTNUM$
Certificate: $CERTNUM$

Dear Doctor,

        The death certificate for _________________________________, who died
on $DEATH_DATE$, contains the following certification for the cause of death:

$CERTIFICATE$

        This certificate contains a condition that is normally valid only for
decedents who are $EDIT_CAUSE$. The information on the certificate
indicates that this is not the case. In order to assure accurate reporting,
we need to know if the reported information is correct. The apparently invalid
condition on this certificate was:

$CAUSE$

        Your attention and prompt reply is appreciated.

                                                Sincerely

                                                Stat S. Tician
                                                State Registrar

Was the decedent $EDIT_CAUSE$?  Yes[ ]  No[ ]
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If no, please supply the decedent's age and sex below:

Age: ________________  Sex: __________

                                                ________________________,M.D.
                                                (Signature of Physician)
                           (Please see other side)
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Below is a query letter used to acquire more information about rare or unusual causes of
death.

                                                Stat S. Tician
                                                State Dept. Vital Statistics
                                                P.O. Box 00000
                                                Capital City, NC  27709

$DATE$

Regarding death certificate:

Lot Number:  $LOTNUM$
Certificate: $CERTNUM$

Dear Doctor,

        The death certificate for _________________________________, who died
on $DEATH_DATE$, contains the following certification for the cause of death:

$CERTIFICATE$

        Some infectious diseases are, or have become, so scarce in the United
States that they are only rarely the cause of death. But because they are
generally recognized as communicable or transmissible and a threat to the
community, they are automatically verified with the certifying physician to
avoid undue public alarm or concern. In case there was some misunderstanding
as the cause of death as originally reported, would you please verify the
condition on this death certificate? The rare cause reported on this
certificate was:

$CAUSE$

        Your attention and prompt reply is appreciated.

                                                        Sincerely,

                                                        Stat S. Tician
                                                        State Registrar



National Center for Health Statistics Super-MICAR

System Manager's Manual Page 91

Is this cause of death as stated above correctly reported? Yes____  No ____
If no, please state the correct disease____________________________________

                                ____________________________________,M.D.
                                (Signature of Physician)

                        (Please see other side)
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Below is a query letter used to request more information on trivial or confusing causes of
death.

                                                Stat S. Tician
                                                State Dept. Vital Statistics
                                                P.O. Box 00000
                                                Capital City, NC  27709

$DATE$

Regarding death certificate:

Lot Number:  $LOTNUM$
Certificate: $CERTNUM$

Dear Doctor,

        The death certificate for _________________________________, who died
on $DEATH_DATE$, contains the following certification for the cause of death:

$CERTIFICATE$

        For medical research and statistics, the International Classification
of Diseases is used to classify all deaths by cause in the United States and
also in most other countries in the world. This system has its own rules and
logic to achieve two major objectives: maximal accuracy of the reporting and
classification of each death while achieving maximal comparability of the
resultant data across the United states and around the world for study of the
trends and causes of mortality.

        Because some conditions are considered symptoms, signs, ill-defined, or
trivial conditions that would rarely if ever cause death except in conjunction
with other conditions, and in order to classify this death by the most
accurate underlying cause, more information is needed. We would appreciate
your help in classifying this death more accurately. The following condition
was considered trivial on this certificate:

$CAUSE$

        Your attention and prompt reply is appreciated.
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                                                Sincerely

                                                Stat S. Tician
                                                State Registrar

In your opinion, what was the underlying cause of this condition?
___________________________________________________________________________
__
OR
Did this condition give rise to another more serious condition which led to
death? If so, please state: _________________________________________________
___________________________________________________________________________
__

                                                ________________________,M.D.
                                                (Signature of Physician)
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APPENDIX F - SUPER-MICAR INPUT RECORD FORMAT

The Additional Information data from Super-MICAR is given in the same format
described in the following table. All of the certificate data will be written out, followed by
the AI data. A single line of three asterisks (***) will separate the certificate data from the
AI. For example:

All Certificate Data
***
All Additional Information

Mortality Medical Data System
Super-MICAR 1996 INPUT FILE FORMAT

ASCII input file format

Value Col Col Length Description
Beg End

Shipment Number 1 2 2 NCHS ID Information
Numeric, 00 - 15
(Usually month of death or month of
receipt)

Lot Number 3 5 3 NCHS ID Information
Numeric, 000 - 999
(States commonly used "book number")

Data Year 6 6 1 Numeric, 0 - 9, Last digit of data year

State Code 7 8 2 Numeric State code (see APPENDIX A)

Activity Code 9 9 1 New Item
Blank,  0 -  9

Coder Status 10 10 1 NCHS ID Information
Numeric 0 - 9

Certificate 11 16 6 Numeric, 000000 - 999999
Number
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Age Unit 17 17 1 Numeric, determines unit of age value:
0: years < 100
1: years > 100
2: months
3: weeks
4: days
5: hours
6: minutes
Blank: Invalid

Age, Number of 18 19 2 Numeric, age value
Units

Date of Death 20 23 4 Month and day of death: MMDD

Sex 24 24 1 Sex code: M, F, U

Manner of Death 25 25 1 Numeric, Manner of Death Code:
1: Accident
2: Suicide
3: Homicide
4: Deferred
4: Pending Investigation
4: Unclassified
5: Undetermined
6: Self-Inflicted
7: Natural
Blank: Not Specified

Surgery Date 26 35 10 Date Surgery Performed:
MM/DD/YYYY

COD Line Ia 36 155 120 Cause of Death Part I Line A

Interval Line Ia 156 175 20 Interval Part I Line A

COD Line Ib 176 295 120 Cause of Death Part I Line B

Interval Line 296 315 20 Interval Part I Line B
Ib

COD Line Ic 316 435 120 Cause of Death Part I Line C

Interval Line Ic 436 455 20 Interval Part I Line C
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COD Line 1d 456 575 120 Cause of Death Part I Line D

Interval Line Id 576 595 20 Interval Part I Line D

Other Conditions 596 715 120 Cause of Death Part II

Injury Date 716 725 10 Date Value: MM/DD/YYYY

Injury Place 726 765 40 Text place of injury

Injury at Work? 766 766 1 Y, N, or Blank

Injury Description 767 886 119 Injury Description

No Longer In Use 887 888 2 No longer in use.

State Specific 889 906 18 Optional: Used for other information on
Data the death certificate that states want to

retain through the Mortality Medical
Data System.

Occupation Literal 907 936 30 Optional

Industry Literal 937 966 30 Optional

Education 967 968 2 Optional
Numeric, 00 - 17

Incomplete Data 969 969 1 1 - incomplete
Flag blank

Line Ib "Due to" 970 970 1 1 - "Due to" deleted by certifier
Flag blank

Line Ib "Due to" 971 971 1 1 - "Due to" deleted by certifier
Flag blank

Line Ib "Due to" 972 972 1 1 - "Due to" deleted by certifier
Flag blank
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APPENDIX G - CONVERTING FILES

For those who implemented the October 1995 version of Super-MICAR 1996, this section
outlines how to convert files created with that system to a format usable by the second
release of Super-MICAR 1996. The new database format is much more compact than the
previous one. As a result, converting the files could save significant hard drive space.
Files must be converted before they can be used with this version of Super-MICAR
1996.

To convert a data file, follow these steps.

1. From the DOS prompt, change to the <DATA> directory using the following
command:

CD directory

Where directory is the full path name of the directory where data files are stored.

2. Run the conversion program from the DOS prompt by typing:

SUP96CVT <ENTER>

3. A file selection window is displayed showing all the database files in the data
directory. Use the up and down arrow keys to highlight the name of the file to be
converted. When the file name is highlighted, press <ENTER>.

4. The file will be converted. The old file will be stored as a database file. Its name
will be the same as the name that it had before, with the letter O replacing the last
letter of the current file name. For example, the backup for a file named
TEST.DBF would be TESO.DBF, with an AI database name of TESOA.DBF.
Once it is confired that the conversion was successful, the old file can be deleted to
make more space on your hard drive.

5. Repeat steps 2 through 4 to convert other files.
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APPENDIX H - ACTIVITY CODES

0 While engaged in sports activity
Physical exercise with a described functional element such as:
. golf
. jogging
. riding
. school athletics    
. skiing
. swimming
. trekking
. waterskiing

1 While engaged in leisure activity
Hobby activities
Leisure time activities with an entertainment element such as going to the cinema,
to a dance or to a party 
Participation in sessions and activities of voluntary organizations

Excludes: sport activities (.0)

2 While working for income
Paid work (manual)(professional)
Transportation (time) to and from such activities
Work for salary, bonus and other types of income

3 While engaged in other types of work
Domestic duties such as:
. caring for children and relatives
. cleaning
. cooking
. gardening
. household maintenance
Duties for which one would not normally gain an income 
Learning activities, e.g. attending school session or lesson
Undergoing education

4 While resting, sleeping, eating and other vital activities
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Personal hygiene

8 While engaged in other specified activities

9 During unspecified activity
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